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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Welcome to This Guide

Welcome to the HP Release Control User Guide, which explains how to work 
with HP Release Control software. HP Release Control provides a common 
platform of decision support for Change Advisory Board members and 
implementation teams during the release life cycle. HP Release Control 
analyzes each change request in the system and provides real-time 
information and alerts during implementation. In addition, HP Release 
Control enables collaboration, feedback, and review throughout the release 
life cycle. 

This chapter includes:

➤ How This Guide Is Organized on page 10

➤ Who Should Read This Guide on page 11

➤ HP Release Control Documentation on page 11

➤ Additional Online Resources on page 12
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Welcome to This Guide
How This Guide Is Organized

This guide contains the following parts:

 Part I Introduction

Describes the various components of the HP Release Control application.

 Part II User Settings

Describes how to view and configure user properties and Analysis module 
settings for the current HP Release Control user.

 Part III Analyzing Changes

Describes the different change request views and change request 
information displayed across the various tabs in the Analysis module, and 
how to filter change requests, action items, and activities.

 Part IV Monitoring and Implementing Activities

Describes the Director module where you can monitor the status of change 
requests scheduled for implementation, the Implementor module where 
you manage the activities you are implementing, and how you can 
communicate between them.

 Part V Dashboard

Describes how to work with the HP Release Control Dashboard, which 
displays change request data in real time using graphical displays.
10
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Who Should Read This Guide

This guide is intended for members of the Change Advisory Board and 
others involved in the change process who are responsible for assessing the 
business impact of change requests on your organization’s IT environment 
and approving or rejecting the proposed changes, and for the change 
implementors and NOC users who are responsible for implementing the 
changes and for monitoring the implementation progress.

HP Release Control Documentation

HP Release Control comes with the following documentation:

HP Release Control Deployment Guide explains how to install and deploy 
HP Release Control. This guide is accessible in the following formats, from 
the following locations:

➤ in PDF format on the HP Release Control DVD

➤ in PDF format by selecting Help > HP Release Control Documentation 
Library from the HP Release Control application

HP Release Control Configuration Guide explains how to configure the 
various parts of the HP Release Control system. This guide is accessible in 
the following formats, from the following locations:

➤ in PDF format on the HP Release Control DVD

➤ in both PDF format and online HTML help format by selecting 
Help > HP Release Control Documentation Library from the 
HP Release Control application

➤ in HTML help format, from specific HP Release Control application 
windows, by clicking in the window and pressing F1, or by selecting 
Help from the main menu

HP Release Control User Guide explains how to use the HP Release Control 
application. This guide is accessible in the following formats, from the 
following locations:

➤ in PDF format on the HP Release Control DVD
11



Welcome to This Guide
➤ in both PDF format and online HTML help format by selecting 
Help > HP Release Control Documentation Library from the 
HP Release Control application

➤ in HTML help format, from specific HP Release Control application 
windows, by clicking in the window and pressing F1, or by selecting 
Help from the main menu

HP Release Control API Reference explains how to work with HP Release 
Control’s API. The API Reference is available in CHM format on the 
HP Release Control DVD, or from the HP Release Control application by 
selecting Help > HP Release Control Documentation Library.

HP Release Control Readme provides information on what’s new in the 
current version of the product as well as comprehensive information on 
known problems and limitations. The Readme is available in HTML format 
on the HP Release Control DVD, or from the HP Release Control application 
by selecting Help > HP Release Control Documentation Library.

Note: Anything published in PDF format can be read and printed using 
Adobe Reader, which can be downloaded from the Adobe Web site (http://
www.adobe.com).

Additional Online Resources

HP Software Support accesses the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You can also post to 
and search user discussion forums, submit support requests, download 
patches and updated documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

To find more information about access levels, go to:
12
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http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. Choose Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.
13
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1
Introduction to HP Release Control

This chapter includes:

Concepts

➤ Overview of HP Release Control on page 17

Reference

➤ Accessing HP Release Control on page 18
Concepts

Overview of HP Release Control

In a typical release life cycle, after a change enters the system, the change 
goes through an approval, implementation, and review phase. HP Release 
Control supports each one of these phases in the release life cycle. 

Approval 
During the approval phase, the Analysis module provides a detailed analysis 
of each change request in the system. Change Advisory Board (CAB) 
members can view information such as the potential impact of the change 
and the possible risk involved in implementation. The CAB uses this 
information to make more informed and accurate decisions regarding the 
approval of planned changes. 

In addition, the collaboration feature enables CAB members to provide 
feedback about planned changes and approve or reject the changes.
17



Chapter 1 • Introduction to HP Release Control
Implementation
During implementation, the Director and Implementor modules provide 
real-time information regarding change activities. Implementors and release 
teams are able to monitor the status of all change activities on a 24-hour 
timeline view. They receive alerts about issues such as scheduling, collisions, 
and delays, and use the implementation guidelines that were drawn up in 
the Analysis module during the approval phase.

Review
After implementation, the Post Implementation Review (PIR) feature 
provides a platform for reviewers to present their conclusions regarding the 
implemented change. Using information collected during the 
implementation phase, reviewers provide feedback about the overall success 
of the change and satisfaction levels of relevant parties. 

Management and Administration
During the entire release life cycle, IT managers use the HP Release Control 
Dashboard module to view graphic displays of change request and activity 
data in real time. HP Release Control Administrators use the Administration 
module to configure the HP Release Control properties and perform 
administration tasks in the system. 

Reference

Accessing HP Release Control

You access HP Release Control using a Web browser from any computer with 
a network connection (intranet or Internet) to the HP Release Control 
server. For details on Web browser requirements, see "System Requirements" 
in the HP Release Control Configuration Guide.

To access the HP Release Control login page and log in to HP Release 
Control:

 1 Configure the user authentication mode, as described in "User 
Authentication" in the HP Release Control Configuration Guide.
18
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 2 In the Web browser, enter the URL http://<server_name>:<Tomcat server 
port>/ccm if you are not working with an identity management system, or 
http://<server_name>/ccm if you are working with an identity 
management system, where server_name is the name or IP address of the 
HP Release Control server.

 3 Enter the login parameters (user name and password) of a user defined by 
the administrator and assigned to you, and click Log In. After logging in, 
the user name appears in the top right-hand corner of the screen.

To log out of HP Release Control:

When you have completed your session, click Logout in the top right-hand 
corner of the screen.
19
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2
User Preferences

This chapter includes:

Concepts

➤ User Preferences Overview on page 23

Reference

➤ User Preferences User Interface on page 23
Concepts

User Preferences Overview

HP Release Control enables you to view and configure user properties for the 
current HP Release Control user and select the business CIs you want to 
associate with the current user. For more information on configuring user 
settings, see "Configuring User Settings" in HP Release Control Configuration 
Guide.

Reference

User Preferences User Interface

This section includes:

 ➤ User Preferences Dialog Box on page 24
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User Preferences Dialog Box

Details Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view and configure user properties for the 
current HP Release Control user and select the business 
CIs you want to associate with the current user.

To access: Select Preferences > User Preferences.

Important 
Information

If you are working in identity management or LDAP 
mode, you cannot change the user’s password.

Useful Links ➤ "User Authentication" in HP Release Control 
Configuration Guide

➤ "Configuring User Settings" in HP Release Control 
Configuration Guide

Description View and modify the properties of the current HP Release 
Control user that were configured by the administrator.

To access: Click the Details tab in the User Preferences 
dialog box.

Important 
Information

If you are working in identity management or LDAP 
mode, you cannot change the user’s password.

Useful Links "User Authentication" in HP Release Control Configuration 
Guide

GUI Element (A-Z) Description

<First name> First name of the currently logged in user.

<Last name> Last name of the currently logged in user.

<User name> User name with which the current user logs in to 
HP Release Control.

Email address The email address of the current user. This is the email 
address to which notifications are sent for this user.
24



Chapter 2 • User Preferences
Business CIs Tab

Password To change the user’s password, type in a new password. 
This is the password by which the user logs in to 
HP Release Control.

Note: If you are working in identity management or 
LDAP mode, you cannot change the user’s password.

Retype password Retype the password to confirm the password entered in 
the Password box.

Note: If you are working in identity management or 
LDAP mode, you cannot change the user’s password.

Description Enables you to associate business CIs with the current 
user.

Associating a business CI with a user causes the user to 
receive notifications when a change is scheduled which 
impacts the business CI. 

Although the administrator is responsible for the initial 
association of business CIs with users, you can associate 
or remove business CI associations from the current user. 

To access: Click the Business tab in the User Preferences 
dialog box.

Useful Links "Configuring User Settings" in the HP Release Control 
Configuration Guide

GUI Element (A-Z) Description
25
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Show Obsolete. Toggle between hiding and displaying 
the obsolete CIs.

Find. Search for a specific business CI by entering the 
name or part of a name in the search box. The search 
returns all business CIs that contain the entered string 
somewhere in the name.

Click the Find button to run the search.

Move the selected business CIs from the Available 
Business CIs list to the My Business CIs list. The business 
CI is associated with the current user.

Move the selected business CIs from the My Business CIs 
list to the Available Business CIs list. The business CI is 
not associated with the current user.

<View other pages> To view other pages, use the left and right arrows. The 
number between the left and right arrows indicate which 
page is currently being displayed. For example, 3 of 5 
means that the 3rd page out of 5 is being displayed.
26



3
Analysis Preferences

This chapter includes:

Concepts

➤ Analysis Preferences Overview on page 27

Reference

➤ Analysis Preferences User Interface on page 27
Concepts

Analysis Preferences Overview

HP Release Control enables you to configure the settings for the Analysis 
module. For details, see "Analysis Preferences Dialog Box" on page 28.

Reference

Analysis Preferences User Interface

This section includes:

 ➤ Analysis Preferences Dialog Box on page 28
27
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Analysis Preferences Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define the settings for the Analysis 
module for the current HP Release Control user.

To access: Select Module > Analysis > Preferences > 
Analysis Preferences.

GUI Element (A-Z) Description

Auto Save Workspace HP Release Control saves your Analysis module settings 
every two minutes. The next time you log in to 
HP Release Control, the last saved Analysis module 
settings are displayed.

Note: You can choose this option together with the Save 
Now option if required.

Notify me on 
updates to items in 
my Favorites list

Enables you to receive email notifications in the 
following cases:

➤ If there was a change in the status of an action item 
marked as a favorite item

➤ If a derived action item was created from an action 
item marked as a favorite item

➤ If someone commented on a change request marked as 
a favorite item

➤ If a change request marked as a favorite item was 
approved or retracted

➤ If an action item was created for a change request 
marked as a favorite item
28
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Page size Enables you to modify the number of change requests or 
action items displayed by default per page of the Analysis 
module’s Change Requests or Action Items pane.

Default value: 20

Save Now HP Release Control saves your current Change Analysis 
module settings immediately.

Note: You can choose this option together with the Auto 
Save Workspace option if required.

GUI Element (A-Z) Description
29
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4
Analysis Module

This chapter includes:

Concepts

➤ Analysis Module Overview on page 34

➤ Action Items on page 34

➤ Impact Analysis on page 35

➤ Risk Analysis on page 36

➤ Time Periods on page 40

➤ Change Request Collisions on page 41

➤ Similar Changes on page 45

➤ Detected and Latent Changes on page 46

Tasks

➤ Resolve Open Issues before the CAB Meeting on page 48

➤ Use the Change Planner to Reschedule a Change on page 50

➤ Define Time Periods on page 51

Reference

➤ Analysis Module User Interface on page 54
Concepts
33
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Analysis Module Overview

The Analysis module displays a detailed analysis of each change request that 
has entered the system. 

Change Advisory Board (CAB) members can view information such as the 
potential impact of the change and the possible risk involved in 
implementation. The CAB uses this information to make more informed 
and accurate decisions regarding the approval of planned changes.

In addition, the collaboration feature enables CAB members to provide 
feedback about planned changes and approve or reject the changes.

HP Release Control enables you to configure the settings for the Analysis 
module. For details, see "Analysis Preferences Dialog Box" on page 28.

Action Items

Action items are tasks that one user can send another regarding a specific 
change request. The user to whom the action item is assigned—known in 
HP Release Control as the assignee—can choose to perform the task assigned 
to him or return the action item to its creator. If the assignee chooses to 
perform the task, he informs the creator that the action item is done once 
the work has been completed. The creator of the action item then closes the 
item or reopens it, as required.

When the assignee receives an action item for whose completion he must 
involve other users, the assignee can create one or more derived action items 
from the action item he was assigned. However, these action items are not 
directly associated with the original action item and their statuses do not 
impact upon the status of the original action item. The status of the original 
action item does not change until the original item’s assignee informs the 
creator that the item is done.

To monitor specific action items, you can add the items to your Favorites 
list. You can also subscribe to receive email notifications when 
modifications are made to action items. In addition, you can forward an 
action item by email to other users for them to review the item or comment 
on it.
34
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Note: 

➤ A change request can have multiple action items associated with it, but 
an action item can be associated with only one change request.

➤ By default, HP Release Control automatically creates action items for 
certain change requests. For details, see "Configuring the Automatic 
Creation of Action Items" in the HP Release Control Configuration Guide.

Action items can be viewed in two places within the Analysis module:

➤ In the Action Items pane of the Action Items mode. You use the Action 
Items pane to view all the action items in your system, or those that meet 
certain filter criteria. For details, see "Change Requests/Action Items Pane" 
on page 116.

➤ In the Action Items view of the Collaboration tab. You use the 
Collaboration tab to view the action items associated with a specific 
change request. For details, see "Collaborate > Action Items Tab" on 
page 118.

Impact Analysis

Impact analysis calculates the effects of change requests on CIs. Both the CI 
details, and their relationships are imported from HP Universal CMDB. For 
information on how to set up and configure HP Release Control to calculate 
impact analysis, see "Configuring Impact Analysis" in the HP Release Control 
Configuration Guide.

HP Release Control enables you to view the impact analysis calculation 
results for a change request in the Assess > Impact tab. The Assess > Impact 
tab displays the business and system CIs that are affected by the change 
request. This includes general information about the affected business or 
system CIs and an indication of the severity of the impact of the change 
request. For details, see "Assess > Impact Tab" on page 67.
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Risk Analysis

For each change request, HP Release Control calculates a relative risk value 
using the following formula:

where:

➤ Calculated Risk is a relative value between 0 and 100, with a higher 
number indicating a higher relative level of risk. The risk value does 
not reflect an objective, universal risk level. Rather, it indicates the risk 
level of the selected change request relative to the other change 
requests.

➤ Potential Damage represents the potential damage that may result 
from the implementation of the requested change. Potential Damage 
is calculated as a weighted value between 0 and 10, with a higher 
number indicating a higher degree of damage.

➤ Probability of Failure represents the probability that the 
implementation of the change request will fail to some degree and 
cause possible damage as a result. Probability of Failure is calculated as 
a weighted value between 0 and 10, with a higher number indicating a 
higher probability of failure. 

Potential Damage and Probability of Failure are calculated based on risk 
factors that are defined by the HP Release Control administrator during the 
configuration process. 

For example, the administrator could define a Probability of Failure risk 
factor called New_technology, which reflects the amount of time that the 
technology involved in the change request has been used in the 
organization. 

As part of creating a new risk factor, the administrator defines the source of 
the data (for example, a field in the integrated service desk application), 
defines mapping rules that translate the source data into factor values 
between 0 and 10, and assigns a weight to the factor. 

Calculated Risk = Potential Damage x Probability of Failure
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The administrator can also define override rules for the risk calculation. For 
example, the administrator can determine that if the change request 
involves a technology that is new to the organization, the risk level is 
automatically set at 100, regardless of the actual risk calculation. 

Example of Risk Analysis Calculation
This section provides a detailed example of the process involved in 
calculating the risk value for change requests.

During the configuration process, the HP Release Control administrator 
defines a risk factor called New_technology. This will be one of the factors 
used to measure Probability of Failure for every change request processed by 
HP Release Control.

The data source for the New_technology risk factor is a required field in the 
integrated service desk application, which reads as follows: How long (in 
months) has the technology involved in this change been used in your 
organization? Accepted values are any number between 1 and 36.

The administrator assigns the following mapping rules for the 
New_technology risk factor that translate the source data into factor values 
between 0 and 10:

For example, if the technology was introduced 18 months ago, the 
New_technology risk factor receives a score of 5.

The administrator assigns a weight of 4 to the New_technology risk factor. 

Original Data (Range) Factor Score

1-12 months 10

12-24 months 5

24-36 months 0
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The administrator then defines three more risk factors to measure 
Probability of Failure. The following table summarizes the Probability of 
Failure risk factors defined by the administrator and their assigned weights:

After defining the risk factors used to measure Probability of Failure for each 
change request, the administrator performs the same process to define a 
separate set of risk factors that will be used to measure Potential Damage for 
each change request.

Now assume that a particular change request involving a fairly new 
technology is processed by HP Release Control and receives the following 
Probability of Failure risk factor scores:

HP Release Control calculates a weighted value for each factor using the 
following formula: 

Factor Name Weight

New_technology 4

QA_approval 8

Affected_CIs 6

Duration_of_change 2

Total weight = 20

Factor Name Factor Score

New_technology 10

QA_approval 4

Affected_CIs 2

Duration_of_change 0

Weight/Total Weight x Score = Weighted Value
38
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where:

➤ Weight is the weight assigned to the risk factor during the HP Release 
Control configuration process.

➤ Total Weight is the sum of all the weights assigned to the risk factors.

➤ Score is the score of the risk factor as translated from the source data. 
The mapping used to translate source data into a score is defined 
during the HP Release Control configuration process.

Substituting the values for the New_technology risk factor (Weight=4, Total 
Weight=20, Factor Score=10) into this formula, you arrive at a weighted 
value of 2:

Weighted values are calculated for all the Probability of Failure risk factors as 
illustrated below:

The Probability of Failure score is the sum of all the weighted values and 
amounts to 4.2, as illustrated in the above table.

Using the same method (with separately defined risk factors), the Potential 
Damage score is calculated and amounts to 5.

The final risk score, calculated using the original risk analysis formula, 
amounts to 21:

4/20 x 10 =2

Factor Name Factor Score Weight Weighted Value

New_technology 10 4 2

QA_approval 4 8 1.6

Affected_CIs 2 6 0.6

Duration of Change 0 2 0

Total 
weight=20

Probability of 
Failure=4.2

Probability of Failure (4.2) X Potential Damage (5) = Calculated Risk (21)
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As illustrated in this example, the final risk score for the change request 
incorporates all the risk factors which influence both the probability of 
failure and the potential damage of this change request.

To view the risk analysis for a change request, see "Assess > Risk Tab" on 
page 78.

Time Periods

Time periods define when changes may and may not be implemented. The 
types of time periods are:

➤ Change Window. A period of time within which requests are designated 
to be implemented. 

➤ Blackout. A period of time within which requests may not be 
implemented. 

➤ Neutral to Changes. A period of time indicating an external event, such 
as a holiday, which has no direct bearing on request implementation.

For example, to ensure that your company’s service level agreements are 
upheld, you may define a Change Window time period such that changes to 
your corporate Web site may only take place from 12:00 AM to 6:00 AM or 
from 6:00 PM to 12:00 AM. For details on the recommended procedure for 
defining time periods, see "Define Time Periods" on page 51.

In this case, for a request to be considered normal, it must occur completely 
within a Change Window period. If any part of the request occurs outside 
the Change Window period, the entire request is considered to have created 
a Time Period Conflict. For details about viewing Time Period Conflicts, see 
"Assess > Time Period Conflicts Tab" on page 85.
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Likewise, you may define a Blackout time period such that changes to the 
Web site may not take place on Mondays from 12:00 PM to 6:00 PM. 

In this case, for a request to be considered normal, it must occur completely 
outside a Blackout period. If any part of the request occurs inside the 
Blackout period, the entire request is considered to have created a Time 
Period Conflict.

For details on how to configure time periods, see "Configuring Time Periods" 
in the HP Release Control Configuration Guide.

Change Request Collisions

HP Release Control automatically identifies change requests involving 
common key elements that are scheduled to take place at the same time or 
adjacent to one another, causing change request collisions.

Note: All references to change requests in this chapter relate to change 
requests associated with action items as well.

Change requests are defined as colliding when:

➤ A configuration item (CI) or business CI is involved in more than one 
change over the same period of time or adjacent periods of time

➤ The same implementor is responsible for implementing more than one 
change over the same period of time or adjacent periods of time
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➤ A specified field has the same value in more than one change over the 
same period of time or adjacent periods of time

The severity of a collision is measured in terms of the cause of the collision 
and the proximity of the change requests to one another.

This section also includes:

➤ "Collision Proximity Levels" on page 42

➤ "Causes of Collision" on page 43

➤ "Collision Severity" on page 44

Collision Proximity Levels
The proximity level of two change requests can be defined as either Overlap 
or Overlap Warning:

➤ Overlap. The two change requests have overlapping schedules. 

➤ Overlap Warning. In reality, planned changes often exceed their original 
planned duration, which can result in an unforeseen overlap between two 
change request schedules. When two change requests are scheduled in 
close proximity to one another, their proximity level is defined as Overlap 
Warning.

By default, change requests are considered to be within close proximity of 
each other when the time gap between them is shorter than 10% of the 
duration of the earlier change request.
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In the illustration below, the gap between the Change Request A and 
Change Request B is 30 minutes, which is less than 10% of the duration of 
Change Request A. The proximity level between the two change requests is 
defined as Overlap Warning.

Causes of Collision
Two change requests in close proximity to each other are not necessarily 
considered to collide. They could be taking place at the same time without 
having any effect on one another. Change requests collide only if they are in 
close proximity to each other AND share one of the following elements:

➤ Configuration Item (CI). Two change requests involve at least one 
common CI.

If a CI is changed as a direct result of a change request, it is referred to 
as a changed CI (CCI). If a CI is not directly involved in the change 
request, but may be affected as a result, it is referred to as an affected 
CI (ACI).

For example, if a change request involves increasing the memory on 
Server A, Server A is referred to as a CCI. If Host Machine B is 
connected to Server A, but is not directly involved in the change 
request, it is referred to as an ACI.

Note: If you are working with HP Release Control without 
HP Universal CMDB, ACIs are not detected.

➤ Affected Business CI. Two change requests affect at least one common 
business CI. 
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If at least one of the CIs associated with a business CI is a CCI, the 
business CI is referred to as a directly affected business CI (DAB). If all 
of the CIs associated with an business CI are ACIs, the business CI is 
referred to as an indirectly affected business CI (IAB).

➤ Implementor. The same implementor is responsible for implementing 
both change requests.

➤ Specified field value. The value of a predefined or customized field that 
you specify is identical for both change requests.

Collision Severity 
HP Release Control determines the severity of a collision based on the 
elements causing the collision and the proximity between the colliding 
change requests. By default, collision severity levels are configured as 
follows:

Elements Causing 
Collisions

Proximity Level

Overlap Overlap Warning

CCI-CCI Critical Critical

CCI-ACI High High

ACI-ACI None None

DAB-DAB High High

IAB-DAB Medium Medium

IAB-IAB Low Low

Implementor Medium Very Low

<Customer-Defined>

(see note below)

Customer-defined Customer-defined
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For example, if change requests share a common changed CI (CCI-CCI) and 
their proximity level is defined as Overlap, the severity of the collision is 
Critical.

Note:

➤ If there is more than one element causing a collision, the severity is 
determined by the collision with the highest severity. 

➤ If you define one or more fields as collision causes, for each field you 
must specify the collision severity level per proximity level. For example, 
if you add the field Location as a collision cause, you must specify the 
collision severity for both an Overlap and an Overlap Warning related to 
the location.

You change the severity level definitions in the change-flow.settings 
configuration file (<HP Release Control installation directory>\conf\). For 
more information, see "Configuring Collision Calculations" in the 
HP Release Control Configuration Guide.

For information about viewing collision details, see "Assess > Collisions Tab" 
on page 70.

Similar Changes

HP Release Control automatically identifies and compares elements which 
are common to all change requests, and generates a list of existing changes 
which are found to be similar to any proposed change request.

By comparing a proposed change against this list of similar changes, you can 
make use of historical data to gain insight into the nature of the proposed 
change, and therefore better predict its likely outcome.
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This feature is based on an adaptive algorithm developed by HP Labs. A user 
with the Similarity Teacher role can tune this algorithm by adding, deleting, 
or confirming similar changes.

In other words, by tuning the similarity algorithm, the Similarity Teacher 
actually modifies the way HP Release Control calculates similarity between 
change requests, thereby yielding more meaningful results in the future.

For more information about similar changes, see "Assess > Similar Changes 
Tab" on page 81.

Detected and Latent Changes

By default, HP Release Control contains all the changes that are scheduled to 
take place in your environment. However, you can configure the 
HP Universal CMDB to periodically search for actual changes to your 
environment and send data about these changes to HP Release Control.

Note: This feature may not be available in your HP Release Control 
application. For more information, contact your HP Release Control 
administrator.
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This section also includes:

➤ "Understanding Scheduled and Discovered Changes" on page 47

➤ "Viewing Detected Changes" on page 47

➤ "Viewing Latent Changes" on page 47

Understanding Scheduled and Discovered Changes
You can use HP Release Control to view data for two types of changes: 

➤ Discovered changes. Actual completed changes discovered in your 
environment by the HP Universal CMDB. 

➤ Scheduled changes. All changes scheduled to take place in your 
environment that are contained in HP Release Control.

HP Release Control matches all discovered changes with scheduled changes 
according to certain criteria. Depending on how the changes match up, 
each discovered change is then classified as either a detected change or as a 
latent change.

Viewing Detected Changes
When a discovered change matches a scheduled change according to all of 
the matching criteria, HP Release Control defines the change as a detected 
change. For details on how to view detected changes, see "Review > 
Verifications Tab" on page 145.

Viewing Latent Changes
When a detected change does not match any scheduled change, or matches 
only according to some of the matching criteria, HP Release Control defines 
the change as a latent change. 

Latent changes are displayed as separate changes in the Change Requests 
List View, along with all the other change requests. A latent change is 
indicated by the Latent icon and the words Latent change in the List view’s 
Summary column. For details on how to view detected changes, see "Review 
> Verifications Tab" on page 145.
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You can work with the latent change feature in different ways. This section 
assumes that the latent change feature is fully activated. For more 
information about the different latent change modes, see "Using the Pre- 
and Post-Change Request Processing Functions" in the HP Release Control 
Configuration Guide.

Tasks

Resolve Open Issues before the CAB Meeting

This task describes how to identify change request collisions associated with 
changes scheduled to be discussed during the next Change Advisory Board 
meeting. Then, it describes how to resolve the problems prior to the 
meeting, so that the CAB discussion can focus only on issues which cannot 
be resolved offline.

This task includes the following steps:

➤ "View the Change Requests to be Discussed at the CAB Meeting" on 
page 48

➤ "Sort the Change Requests by Collision Severity" on page 49

➤ "Create an Action Item" on page 49

 1 View the Change Requests to be Discussed at the CAB 
Meeting

Elizabeth Hampton is the Change Manager for the ABC Software 
Company. First she selects Module > Analysis. In the Change Requests/
Action Items pane, she selects View > Change Requests and then clicks 

 List. She then clicks the downward arrow  to the right of the 
Change Requests box and selects the Next CAB Meeting filter to view the 
change requests that are scheduled to be discussed at the next CAB 
meeting. For more information about filtering change requests, see 
"Activity Filter/Change Request Filter/Action Item Filter Dialog Box" on 
page 152.
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 2 Sort the Change Requests by Collision Severity

In the Change Requests pane, Elizabeth clicks the header of the Collision 
Severity column to sort the change requests by severity. The colliding 
change requests appear at the top of the list and the changes having the 
highest severity appear first.

For more information about change request collision, see "Change 
Request Collisions" on page 41.

 3 Create an Action Item

Elizabeth creates an action item for each colliding change to request that 
the collisions be resolved before the next CAB meeting. 

In the Analysis and Details pane, she selects the change request for which 
she wants to create a new action item, and then clicks the 
Collaborate > Action Items tab. She then clicks the New Action Item  
button to open the Add Action Item dialog box and assigns the action 
item to the relevant person. For more information on how to create an 
action item, see "Add/Edit Action Item Dialog Box" on page 64.
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Use the Change Planner to Reschedule a Change

This task includes the following steps:

➤ "Select a New Schedule in the Change Planner" on page 50

➤ "Run a Simulation in the Change Planner" on page 50

➤ "View the Summary Information" on page 50

➤ "View the Impact Analysis of the Simulation" on page 51

➤ "View the Collision Analysis of the Simulation" on page 51

➤ "View the Time Periods Conflicts Analysis of the Simulation" on page 51

➤ "View the Risk Analysis of the Simulation" on page 51

 1 Select a New Schedule in the Change Planner

Select Module > Analysis and in the Change Requests/Action Items pane, 
click the Plan Selected Change button to open the Change Planner. In the 
Scheduling pane, use the calendars in the Planned start and Planned end 
boxes to set a new schedule. For details, see "Scheduling Pane" on page 92.

 2 Run a Simulation in the Change Planner

In the Change Planner, click the Run Simulation button to run the 
simulation.

 3 View the Summary Information 

In the Change Planner, click the Preview tab to display the:

➤ Current planned times of the change compared with the simulated 
time.

➤ Summary of the current analysis results compared with the simulated 
analysis results. For more information on the Preview tab, see "Preview 
Tab" on page 95.
50



Chapter 4 • Analysis Module
 4 View the Impact Analysis of the Simulation 

In the Change Planner, click the Impact tab to display the impact analysis 
of the simulation. For more information about viewing impact analysis 
results and the filter options, see "Impact Tab" on page 95.

 5 View the Collision Analysis of the Simulation

In the Change Planner, click the Collisions tab to display the collision 
analysis of the simulation. For more information about viewing collision 
analysis results and the filter options, see "Collisions Tab" on page 96.

 6 View the Time Periods Conflicts Analysis of the Simulation

In the Change Planner, click the Time Periods Conflicts tab to display the 
time period conflicts analysis of the simulation. For more information 
about viewing time period conflicts analysis results and the filter options, 
see "Time Period Conflicts Tab" on page 97.

 7 View the Risk Analysis of the Simulation

In the Change Planner, click the Risk tab to display the risk analysis of the 
simulation. For more information about viewing time risk results, see 
"Risk Tab" on page 98.

Define Time Periods

This task describes the recommended procedure for defining time periods.

This section includes:

➤ "Identify the Change Window and Blackout Periods" on page 52

➤ "Define a Filter" on page 52

➤ "Define a Time Period Category" on page 54
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Identify the Change Window and Blackout Periods
Time periods define when changes may and may not be implemented. 

When defining time periods, it is recommended to first identify the Change 
Windows and the Blackout periods in your organization. 

➤ A Change Window is a period of time within which requests are 
designated to be implemented. For example, you may define a Change 
Window that allows you to make changes to your company’s Web site 
only from Saturday at 5:00 PM to Sunday at 11:00 PM.

➤ A Blackout period is a period of time within which requests cannot be 
implemented. For example, you might need to define a Blackout period 
that restricts you from making any changes to your company’s Web site 
during periods that extend from the first day after the end of each fiscal 
quarter, to the day after your company issues a press release regarding the 
company’s performance in that quarter.

Define a Filter
Define a filter that is relevant to the Change window or Blackout period you 
identified in your organization. 

For example, if your organization needs to make changes to your SAP 
application, you can create a filter that displays change requests whose 
impact analysis results affect certain business CIs. You define the filter to 
include the business CIs that are associated with the SAP application.
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In the Business CIs tab of the Change Request Filter dialog box, you select 
the Business CIs you want to include in the filter. In the following example, 
a SAP business CI is selected.

For details on how to create a filter, see "Activity Filter/Change Request 
Filter/Action Item Filter Dialog Box" on page 152.

When you save the filter, give it an appropriate name, for example, 
sap_application, and then select the Time Period Filter check box. The filter 
then appears in the Matching Changes: Filter box in the Administration 
module’s Time Periods tab and you can select this filter when defining a 
time period category. 

For details on defining time periods, see "Configuring Time Periods" in the 
HP Release Control Configuration Guide.
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Define a Time Period Category
After you create the relevant filters, you configure a time period category for 
each Change Window and Blackout period. If there is more than one type of 
Change Window and Blackout period, you must define a different category 
for each one. 

For example, you have to define a Change Window for both your SAP and 
Siebel applications. You may define a Change Window in which changes to 
the SAP application may only take place every Friday from 10:00 PM to 
11:30 PM and another Change Window in which changes to the Siebel 
application may take place every Saturday night from 9:00 PM to 11:00PM. 
In this case, you would define a different time period category for each 
Change Window.

The Time Periods tab in the Administration module enables you to define 
new time period categories. When you define a new time period category 
relating to the SAP application, you can select the sap_application filter from 
the Matching Changes: Filter box to instruct HP Release Control to include 
the change request in the current category. You then define the required 
recurrence rule you want to apply to the time period category.

For details on defining time periods, see "Configuring Time Periods" in the 
the HP Release Control Configuration Guide.

Reference

Analysis Module User Interface

This section describes (in alphabetical order):

 ➤ Action Items Pane on page 56

 ➤ Add Change Request to Similarity Set Dialog Box on page 63

 ➤ Add/Edit Action Item Dialog Box on page 64

 ➤ Approve/Retract Change Request Dialog Box on page 66

 ➤ Assess > Impact Tab on page 67

 ➤ Assess > Collisions Tab on page 70

 ➤ Assess > Risk Tab on page 78
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 ➤ Assess > Similar Changes Tab on page 81

 ➤ Assess > Time Period Conflicts Tab on page 85

 ➤ Change Planner Dialog Box on page 90

 ➤ Change Requests — Calendar View on page 99

 ➤ Change Requests — List View on page 103

 ➤ Change Requests — Timeline View on page 108

 ➤ Change Requests Pane on page 111

 ➤ Change Requests/Action Items Pane on page 116

 ➤ Collaborate > Action Items Tab on page 118

 ➤ Collaborate > Discussion Tab on page 119

 ➤ Collaborate > Resolution Tab on page 121

 ➤ Details and Analysis Pane on page 126

 ➤ Impact Graph Window on page 127

 ➤ New Discussion Thread Dialog Box on page 128

 ➤ Post Implementation Review Dialog Box on page 129

 ➤ Preview > Details Tab on page 132

 ➤ Preview > Overview Tab on page 134

 ➤ Report Details Dialog Box on page 138

 ➤ Respond Dialog Box on page 140

 ➤ Review > Conclusions Tab on page 142

 ➤ Review > Event Log Tab on page 144

 ➤ Review > Verifications Tab on page 145
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Action Items Pane

Action Items List Pane

Description Displays action items that have been created from 
change requests as well as the basic information and user 
comments for each action item selected from the list.

To access: In the Change Requests/Action Items pane, 
select View > Action Items.

Useful Links "Action Items" on page 34

Description Displays a list of the action items.

Important 
Information

➤ By default, the Action Items mode displays all the 
action items that were created from all the change 
requests in the system.

➤ You can sort the order of appearance of the requests 
according to each column by clicking the required 
column heading.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Opens the Respond dialog box, which enables the 
following:

➤ Any user to post comments.

➤ The assignee to mark an open action item as Done or 
return the item to its creator.

➤ The creator to reopen an action item marked as Done.

For more information, see "Respond Dialog Box" on 
page 140.

Note: Enabled only when the action item selected is 
assigned to the current user.

Close Action Item. Enables the creator to change the 
status of the action item to Closed.

Note: Enabled only when the action item selected is 
assigned to the current user.

Edit Action Item. Enables the creator to edit an open 
action item. Opens the Add/Edit Action Item dialog box.

Note: Enabled only when the action item selected is 
assigned to the current user.

New Action Item. Enables you to create a new action 
item associated with the same change request as the 
selected action item. Opens the Add/Edit Action Item 
dialog box,

Delete Action Item. Enables the creator to delete an 
action item.

Note: Enabled only when the action item selected is 
assigned to the current user.

Forward by E-Mail (FYI). Enables you to send an action 
item by email for information purposes. Opens the Send 
E-mail dialog box.
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Add Selected Action Item to Favorites/ Delete Selected 
Action Item from Favorites. Toggles between adding or 
removing the selected action item from the Favorites 
filter. For information about Filters, see "Filtering Change 
Requests, Activities, and Action Items" on page 147.

Click the drop-down arrow and select one of the 
following options:

➤ Delete from Favorites. Deletes the selected action 
items from the Favorites filter.

➤ Delete all AI's in the Favorites Filter. Deletes all the 
action items in the Favorites filter.

Note: You can also subscribe to receive notifications 
when certain modifications are made to favorite action 
items. For details, see "Analysis Preferences User 
Interface" on page 27.

Subscribe to Selected Action Item/Unsubscribe from 
Selected Action Item. Enables you to receive email 
notifications or cancel a notification subscription for the 
selected action item. For information on configuring 
notification rules and conditions, see "Configuring 
Notifications" in the HP Release Control Configuration 
Guide.

Go to Parent Action Item. Displays the parent action 
item for the selected derived action item.

GUI Element (A-Z) Description
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<View other pages> ➤ When you are in List view, you can view other pages 
by using the left and right arrows. 

The number between the left and right arrows indicate 
which page is currently being displayed. For example, 
3 of 5 means that the 3rd page out of 5 is being 
displayed.

➤ When you are in Calendar view or Timeline view: 
Group by Change Request, you can click the 
navigation arrows adjacent to the date to scroll 
through to the required date.

Navigating through the calendar or timeline or is relative 
to the time frame selected.

For example:

➤ In the Timeline view, if Month is selected, clicking the 
navigation button to the right of the date box displays 
the change requests for the following month.

➤ In the Calendar view, clicking the navigation button 
to the left of the date box displays the change requests 
for the previous week.

Assigned to Displays the name of the user to whom the action item 
was assigned. This user can respond to the request in one 
of the following ways:

➤ Complete the task involved and mark the action item 
as Done once it has been completed.

➤ Reject the request and return it to the creator.

If necessary, the assignee can also create a new, derived 
action item from the current action item.

Creator Displays the name of the user who created the action 
item. The creator is also the user responsible for marking 
the action item as Closed.

GUI Element (A-Z) Description
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Due date The day by which the creator determined that the action 
item must be completed. If this date has passed and the 
item has not been closed, the due date is displayed in red.

A tooltip indicating the due date (including the day and 
hour) of the action item is visible when you hold the 
mouse pointer over the action item icon. If the due date 
has passed and the item has not been closed, [Expired] is 
also included in the tooltip.

ID Displays the HP Release Control-generated ID number of 
the action item.

Modified Displays the date (including the day and hour) on which 
the action item was last modified. If the item has not 
been modified since its creation, this column displays the 
item’s creation date and time.

Pending on Displays the name of the user whose action is being 
awaited. If the item is open, the name of the assignee, 
who is supposed to mark the item as Done, is displayed 
in this column (unless the assignee returned the item to 
the creator). If the item is marked as Done, the name of 
the creator, who is supposed to mark the item as Closed, 
is displayed in this column.

Priority Displays a colored flag indicating the priority level that 
the creator assigned to the action item.

The color of the flag indicates the priority level as 
follows:

➤ Red – High

➤ Yellow – Normal

➤ Green – Low

A tooltip indicating the priority of the action item is 
visible when you hold the mouse pointer over the action 
item icon.

GUI Element (A-Z) Description
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Action Item Posting Pane

Status Displays an icon indicating the status of the action item.

The following icons indicate the following statuses:

➤  Open

➤  Done

➤  Closed

A tooltip indicating the status of the action item is visible 
when you hold the mouse pointer over the action item 
icon.

Subject Displays a brief overview of the action item. Parent 
action items can be expanded to display all the derived 
action items. To expand or collapse action items, click 
the Expand button to the left of the item.

Derived action items are displayed in light blue.

Description Displays basic information and user comments for each 
action item selected from the Action Items List pane.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Assignee Displays the name of the user to whom the action item 
was assigned. If the action item is pending on the 
assignee, a bullet appears to the right of the assignee’s 
name.

Comments Displays the comments that were posted regarding the 
action item. Each comment contains a header that 
includes the name of the user who posted the comment 
and the date and time of the comment’s posting.

The subject of the comment is displayed in blue text and 
the description entered by the user is displayed in black 
text.

Note: Comments can be posted by any HP Release 
Control user.

Creator Displays the name of the user who created the action 
item. If the action item is pending on the creator, a bullet 
appears to the right of the creator’s name.

Date due The day by which the creator determined that the action 
item must be completed.

Status Displays the status of the action item. The possible 
options are:

➤ Open

➤ Done 

➤ Closed

Subject Displays the subject line of the action item (above the 
comments).
62



Chapter 4 • Analysis Module
Add Change Request to Similarity Set Dialog Box

The following elements are included:

Description HP Release Control calculates similar changes according 
to specific criteria as defined in the similar settings 
directory. A user with a Similarity Teacher role can add 
requests to the Similar Changes list even if they are not 
automatically regarded as being similar according to 
these criteria. 

To access: In the Details and Analysis pane, click 
Assess >  Similar tab, and then click the Add Change 
Request to Similarity Set  button.

Useful Links ➤ "Configuring User Settings" in the HP Release Control 
Configuration Guide.

➤ "Similar Changes" on page 45

GUI Element (A-Z) Description

Request ID Enter the ID of the request you want to add to the list.

Service Desk Select the required service desk.
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Add/Edit Action Item Dialog Box

Description Enables you to create an action item for a specific change 
request or edit an existing action item.

To access: In the Change Requests/Action Items pane, 
select View > Action Items. If you are in Action Items 
mode, select the action item for whose associated change 
request you want to create a new action item. If you are 
in Change Requests mode, select the change request for 
which you want to create a new action item. 

➤ To create an action item, click New Action Item  
from the toolbar in the Change Requests/Action Items 
pane.

If you select an action item and are the action item’s 
assignee, choose whether you want to create the 
action item as a new item or as a derived action item. 
A derived action item is listed under the parent item in 
the Action Items List pane.

The action item you create is added to both the Action 
Items pane and the Action Items view of the 
associated change request’s Collaboration > Action 
Items tab. An email notification is sent to the assignee.

➤ To edit an existing action item, click Edit Action Item 
 from the toolbar in the Change Requests/Action 

Items pane. The Edit Action Item button is only 
enabled when the action item selected is assigned to 
the current user. 

The action item properties are updated in both the 
Action Items List pane and the Action Items view of 
the associated change request’s Collaboration tab.

Notes:

➤ When modifying an action item, you cannot 
modify the level (parent/derived) of the action 
item.

➤ The Edit Action Item  button is only enabled 
when the action item selected is assigned to the 
current user and the status of the item is not 
Closed.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

The creator of an action item can only modify the 
assigned action item if it is still open. For details about 
the statuses of action items, see "Status" on page 61.

Useful Links "Action Items" on page 34

GUI Element (A-Z) Description

Assignee Select a user to whom you want to assign the selected 
action item. Click Assignee  to the right of the 
Assignee box. The Select Users dialog box opens.

Locate and select the user to whom you want to assign 
the action item. The user name of the user you selected 
appears in the Assignee box.

Creator The creator of the action item.

Description (Optional) A free text box containing a brief description 
of the action item.

Due Date Select the date and time by which the action item should 
be completed. Click the calendar  button to the right 
of the Due Date box to select the date and time. The date 
appears in the Due Date box.

Note: You select the time according to your machine’s 
time zone, as indicated in the calendar box.

Priority Select the priority you want to assign the action item. 
The options are:

➤ Low

➤ Medium

➤ High

Request ID The ID of the change request.

Subject A brief overview of the action item.
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Approve/Retract Change Request Dialog Box

Description Enables you to approve/retract a change request.

In the Comments box, enter the information you want 
HP Release Control to display as part of your approval/
retraction. This information is not transferred to the 
service desk application.

Enter the user name and password of your service desk 
application in the Login dialog box that opens. 
HP Release Control saves this information until you end 
your session so that you do not have to re-enter this 
information for each change request that you want to 
approve or retract.

If you configured the selected change request to contain 
a URL link to the original request in the service desk 
application, you can view the request in the service desk 
application by clicking Open the original request in the 
service desk application.

When you click Approve or Retract, HP Release Control 
checks whether your user name and password are correct 
and whether you are currently allowed to approve/retract 
the change request. If so, HP Release Control approves/
retracts the request and the details appear in the 
Collaborate tab.

For more information on approving a change request or 
retracting the approval, see "Collaborate > Resolution 
Tab" on page 121.

To access: In the Analysis and Details pane, click 
Collaborate > Action Items tab, and then click the 
Approve  or Retract button in the Change 
Approval pane.
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Assess > Impact Tab

Important 
Information

➤ The Approve/Retract buttons are enabled only if the 
required criteria are met. For details, see 
Collaborate > Resolution tab.

➤ If the authentication data you provided is incorrect, or 
if you are not currently allowed to approve the change 
request, HP Release Control issues a detailed error 
message. If the service desk application’s version of the 
request is more current than the version in HP Release 
Control, you receive a message asking whether you 
want to force the approval of the change request. 
Select the check box and click Approve to force 
approval.

➤ To view details of your approval, click the Approval 
Log  button in the Change Approval pane of the 
Collaborate > Resolution tab.

➤ If you have retracted the approval of the change 
request, the retraction details appear in the Cab 
Decisions pane of the Collaborate > Resolution tab.

➤ To update a change request’s status in the Change 
Requests pane, click the Refresh  button. The 
request’s status is updated once HP Release Control 
receives the updated request from the service desk 
application. This may take a few seconds.

Useful Links "Collaborate > Resolution Tab" on page 121

Description Describes how to view the impact analysis calculation 
results for a change request. The Impact tab displays the 
business and system CIs that are affected by the change 
request. This includes general information about the 
affected business or system CIs and an indication of the 
severity of the impact of the change request. 

To access: In the Analysis and Details pane, click the 
Assess > Impact tab.

Useful Links "Impact Analysis" on page 35
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Open Graph Window. Enables you to view the impact 
analysis calculation results in graphic format. Opens the 
Impact Graph window.

CI Attributes. Enables you to view the attributes of the 
selected CI. Opens the CI Attributes window.

Note: To customize the attributes that HP Release 
Control displays, see "Configuring HP Universal 
CMDB-Related Settings" in HP Release Control 
Configuration Guide.

Expand/Collapse. Enables you to expand/collapse a CI to 
display/hide all the child CIs.

<Impact Severity 
Levels of Business 
CIs>

The icons to the left of each business CI name indicate 
whether the business CI is directly or indirectly affected 
by the change request:

➤  The business CI is directly affected by the change 
request (DAB). This means that at least one CI 
associated with the business CI is a CCI.

➤  The business CI is indirectly affected by the 
change request (IAB). This means that all of the CIs 
associated with the business CI are ACIs.

If a CI is triggered directly from the ticket (Triggered CI), 
a black circle surrounds the impact severity level  
icon.

From each affected business CI, you can filter the change 
requests so that only those that affect the current 
business CI are displayed. You do this by right-clicking 
the affected business CI and choosing Quick filter: show 
affecting requests from the menu. The change requests 
that affect this business CI are displayed in the Change 
Requests pane.
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<Impact Severity 
Levels of System CIs>

The impact severity level of a CI that is explicitly 
mentioned in the ticket (Triggered CI) is automatically 
set to critical. The severity of any CIs which are not 
triggered CIs are calculated by HP Universal CMDB.

Following are the default impact severity level icons:

 Critical

 High

 Medium

 Low

 Very 

 No impact analysis available

➤ If a CI is directly affected by the change CI (CCI), a 
black circle surrounds the impact severity level  
icon.

➤ If a CI is triggered directly from the ticket (Triggered 
CI), a ticket symbol is added to the impact severity 
level  icon.

A tooltip indicating the impact severity level of the 
business or system CI is visible when you hold your 
mouse over the severity level icon. CCI indicates that the 
CI changes as a result of the change request. ACI indicates 
that the CI is affected by the modification of the change 
request.

Note: If you are working with HP Release Control 
without HP Universal CMDB, ACIs cannot be detected.

Affected by Displays the CIs which have an affect on the selected CI.

Affects Displays the CIs which are affected by the selected CI.

Impact CIs Displays the affected and changed CIs (ACIs and CCIs). 

GUI Element (A-Z) Description
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Assess > Collisions Tab

Colliding Changes Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays details about all the change requests that collide 
with the change request selected in the Change Requests 
pane.

You can view collisions in the List view or Timeline view. 
In both views, the causes of collisions are also displayed.

To access: In the Analysis and Details pane, click 
Assess > Collisions tab.

Included in Tasks "Resolve Open Issues before the CAB Meeting" on page 48

Useful Links "Change Request Collisions" on page 41

Description Enables you to view collisions in the List view or 
Timeline view. 

GUI Element (A-Z) Description

List. Displays the change requests that collide with the 
change request selected in the Change Requests pane in 
table format. For details, see "List View" on page 74.

Timeline. Displays colliding change requests as solid bars 
on a timeline. For details, see "Timeline View" on 
page 77.
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Collision Causes Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Go to Colliding Request. Enables you to view the change 
request with which the colliding change request 
displayed in the Colliding Changes pane collides in the 
Change Request pane.

Zoom in/Zoom out. Enables you to divide the timeline 
into 1-hour or 6-hour time intervals. Click the arrow next 
to the Zoom in/Zoom out button to select the required 
interval.

Note: Available in Timeline view only.

Description Displays the details of the factors causing the collision of 
the selected change request in the in the List or Timeline 
view.

Important 
Information

If you are working with HP Release Control without 
HP Universal CMDB, ACIs cannot be detected. The only 
CI-related cause of collision, then, is CCI-CCI.

GUI Element (A-Z) Description

Expand All/Collapse All. Enables you to expand or 
collapse the collision causes.

CI Attributes. Enables you to view the attributes of the 
selected CI. Opens the CI Attributes window.

Note: To customize the attributes that HP Release 
Control displays, see "Configuring HP Universal 
CMDB-Related Settings" in the HP Release Control 
Configuration Guide.

GUI Element (A-Z) Description
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<Collision Cause: 
Business CI>

If a commonly affected business CI causes the collision, it 
is listed in the Collision Causes pane, under Business CI.

The icon to the left of the business CI indicates whether 
it is directly or indirectly affected by the collision.

➤  If at least one of the CIs associated with the 
business CI is a CCI, then the business CI is directly 
affected by the collision. 

➤  If all of the CIs associated with the business CI are 
ACIs, then the business CI is indirectly affected by the 
collision.

Note: You can filter the change requests so that only 
those that affect a particular business CI are displayed. To 
do this, right-click the business CI in the Collision Causes 
pane and select Quick filter: show affecting requests. 
Only the change requests that affect this business CI are 
displayed in the Change Requests pane.

GUI Element (A-Z) Description
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<Collision Cause: 
Implementor>

If one of the collision causes is a common implementor, 
the name of the implementor responsible for 
implementing the change requests is displayed in the 
Collision Causes pane, under Implementors.

<Collision Cause: 
System>

If one of the collision causes is commonly affected 
system CIs, you can view a list of these CIs in the 
Collision Causes pane, under System.

The colliding CIs are listed alongside icons that indicate 
the impact severity of the CIs. For more information 
about impact severity, see "Assess > Impact Tab" on 
page 67.

GUI Element (A-Z) Description
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List View

Description Displays the change requests that collide with the change 
request selected in the Change Requests pane in table 
format. The table is sorted in order of the severity of the 
collisions.

Hold the cursor over an element in the table to view a 
tooltip with relevant information.

To access: In the Details and Analysis pane, select Assess 
> Collisions and then click List  in the Colliding 
Changes pane.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Collision severity> Displays an icon indicating the severity of the collision. 
If there are multiple causes for a collision, the collision 
severity is determined by the most severe of the causes.

Collision severity is indicated as follows:

 Critical (red)

 High (orange)

 Medium (yellow)

 Low (khaki)

 Very Low (olive green)

For details about how collision severity is calculated, see 
"Change Request Collisions" on page 41.

<Proximity level> Displays an icon indicating the collision proximity level.

Collision proximity is indicated as follows:

 Overlap

 Overlap warning

For more information about collision proximity levels, 
see "Change Request Collisions" on page 41.
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Causes Displays the causes of the collision. Change request 
collisions can be caused by several factors (CI-, business 
CI-, implementor-, or field-related). If multiple factors 
cause a collision, all of the factors are listed. 

The following is a list of all the possible collision causes:

➤ CCI-CCI. A common CI is changed by both change 
requests.

➤ CCI-ACI. A common CI is changed by one of the 
change requests and indirectly affected by the other 
change request.

➤ ACI-ACI. A common CI is indirectly affected by both 
change requests.

➤ DAB-DAB. A common business CI is directly affected 
by both change requests.

➤ IAB-DAB. A common business CI is directly affected by 
one of the change requests and indirectly affected by 
the other change request.

➤ IAB-IAB. A common business CI is indirectly affected 
by both change requests.

➤ Implementor. A common implementor is responsible 
for implementing both change requests.

➤ Field. A specified field has the same value in both 
change requests.

For more information about collision causes, see "Change 
Request Collisions" on page 41.

End Displays the date on which the implementation of the 
conflicting change request is scheduled to end.

Request ID Displays the service desk application request ID of the 
conflicting change request.

Start Displays the date on which the implementation of the 
conflicting change request is scheduled to begin.

Summary Displays a brief overview of the conflicting change 
request.

GUI Element (A-Z) Description
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Timeline View

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays colliding change requests as solid bars on a 
timeline. Each block represents a different colliding 
change request.

The change request selected in the Change Requests pane 
is always displayed first on the timeline, and is labeled 
Reference. The colliding change requests are labeled by 
their request IDs.

The color of the bar indicates the severity of the collision. 
If there is more than one cause for a collision, the 
collision severity is determined by the most severe cause.

To access: In the Details and Analysis pane, select Assess 
> Collisions. Then click List  in the Colliding 
Changes pane.

GUI Element (A-Z) Description

<Collision severity> By default, the collision severity is indicated as follows:

➤ Red – Critical

➤ Orange – High

➤ Yellow – Medium

➤ Khaki – Low

➤ Olive Green – Very low

➤ Gray – No collision analysis available
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Assess > Risk Tab

The following elements are included:

Description Enables you to view the risk analysis for a change 
request. The Risk tab displays an overall summary of the 
risk analysis for the selected change request, including 
distribution charts of the risk factors contributing to the 
Potential Damage and Probability of Failure calculations. 
These distribution charts enable you to pinpoint the 
most significant factors contributing towards the risk 
level of the selected change request.

The risk calculation is displayed in the Risk Information 
pane. If an override rule is in place, details of the override 
rule are displayed alongside the distribution charts. 

For details on performing risk analysis on change 
requests, see "Configuring Risk Analysis" in the HP Release 
Control Configuration Guide.

To access: In the Analysis and Details pane, click 
Assess >  Risk tab.

Useful Links "Risk Analysis" on page 36

GUI Element (A-Z) Description

Drill Down. Displays the risk calculation details in the 
Potential Damage and Probability of Failure panes.

Returns to the upper level view.

Potential Damage Displays a graphic illustration that represents the 
potential damage that may result from the 
implementation of the requested change. Potential 
Damage is calculated as a weighted value between 0 and 
10, with a higher number indicating a higher degree of 
damage.

Note: This graph also appears in the lower level view, 
after clicking  Drill down.
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Potential Damage 
Factor Details

Displays the details about each risk factor in table format.

The table includes the following columns: 

➤ Data. The source data for the risk factor—for example, 
data from a field in the integrated service desk 
application.

➤ Description. A description of the risk factor defined 
during the HP Release Control configuration process.

➤ Name. The name of the risk factor defined during the 
HP Release Control configuration process.

➤ Score. The score of the risk factor as translated from 
the source data. The mapping used to translate source 
data into a score is defined during the HP Release 
Control configuration process.

➤ Weight. The weight assigned to the risk factor during 
the HP Release Control configuration process.

➤ Weighted Value. The weighted value of the risk factor 
within the final Potential Damage or Probability of 
Failure score. The weighted value is calculated as 
follows: 

Weighted Value = Weight/Total Weight x Score

where Weight is the weight assigned to the risk factor 
and Total Weight is the sum of all the weights assigned 
to the risk factors.

Probability of Failure Displays a graphic illustration that represents the 
probability that the implementation of the change 
request will fail to some degree and cause possible 
damage as a result. Probability of Failure is calculated as a 
weighted value between 0 and 10, with a higher number 
indicating a higher probability of failure.

Note: This graph also appears in the lower level view, 
after clicking  Drill down.

GUI Element (A-Z) Description
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Probability of Failure 
Factor Details

Displays the details about each risk factor in table format.

The table includes the following columns: 

➤ Data. The source data for the risk factor—for example, 
data from a field in the integrated service desk 
application.

➤ Description. A description of the risk factor defined 
during the HP Release Control configuration process.

➤ Name. The name of the risk factor defined during the 
HP Release Control configuration process.

➤ Score. The score of the risk factor as translated from 
the source data. The mapping used to translate source 
data into a score is defined during the HP Release 
Control configuration process.

➤ Weight. The weight assigned to the risk factor during 
the HP Release Control configuration process.

➤ Weighted Value. The weighted value of the risk factor 
within the final Potential Damage or Probability of 
Failure score. 

The weighted value is calculated as follows: 

Weighted Value = Weight/Total Weight x Score

where Weight is the weight assigned to the risk factor 
and Total Weight is the sum of all the weights assigned 
to the risk factors. 

To access: Click Drill down  in the Probability of 
Failure pane.

Risk Information Displays the risk calculation.

GUI Element (A-Z) Description
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Assess > Similar Changes Tab

The following elements are included:

Description Displays a list of changes that are similar to the change 
request selected in the Change Requests/Action Items 
pane.

For more information about similar changes, see "Similar 
Changes" on page 45.

To access: In the Analysis and Details pane, click 
Assess >  Similar Changes tab.

GUI Element (A-Z) Description

Similar Changes. Displays a list of requests which are 
similar to the selected request in the Change Requests/
Action Items pane.

Statistics. Displays the Outcome and Disrupted Business 
CIs graphs. The information displayed in the graphs is 
aggregated over all the requests displayed in the Similar 
Changes list.

Add Change Request to Similarity Set. HP Release 
Control calculates similar changes according to specific 
criteria as defined in the similar settings directory. If you 
have been assigned the Similarity Teacher role, you can 
add requests to the Similar Changes list even if they are 
not automatically regarded as being similar according to 
these criteria. Opens the Add Change to Similarity Set 
dialog box.

Notes: 

➤ After the request is added to the Similar Changes list, a 
check mark appears in the Confirmed column.

➤ Adding a request to the Similar Changes list influences 
the way HP Release Control calculates future similar 
changes.

➤ This option is only available to a user with the 
Similarity Teacher role.
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Confirm Change Request Similarity. Enables a user with a 
Similarity Teacher role to confirm that a request is 
similar. This guarantees that the request always appears 
in the Similar Changes list, irrespective of any other 
changes that are made to the list.

Notes:

➤ A check mark appears in the Confirmed column next 
to the request that is confirmed as similar.

➤ Confirming a request as similar influences the way 
HP Release Control calculates future similar changes.

➤ This option is only available to a user with a Similarity 
Teacher role.

Delete Change Request from Similarity Set. HP Release 
Control calculates similar changes according to specific 
criteria as defined in the similar settings directory. If you 
have been assigned the Similarity Teacher role, you can 
delete requests from the Similar Changes list even if they 
are regarded as being similar according to these 
definitions.

Notes: 

➤ Deleting a request from the Similar Changes list 
influences the way HP Release Control calculates 
future similar changes.

➤ This option is only available to a user with a Similarity 
Teacher role.

Open Similar Details Window. Enables you to view PIR 
details for any similar change with a Closed status, where 
a PIR was created. The Similar Details window opens and 
displays the Disrupted Business CIs and Review Notes 
information entered during the creation of the PIR. 

For details on creating a PIR, see "Review > Conclusions 
Tab" on page 142.

GUI Element (A-Z) Description
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Go to Similar Request. Enables you to view the list of 
similar changes for any request that appears in the 
Similar Changes list.

The selected request is displayed in the Change Requests 
list view, and the Similar Changes list is updated to 
display the list of similar changes for the newly selected 
request.

Confirmed Indicates requests which have been added to the list or 
have been confirmed as being similar. For more 
information about similar changes, see "Similar Changes" 
on page 45.

To access: Click the Similar Changes  button.

Disrupted Business 
CIs pane

Specifies which other business CIs were affected by the 
similar changes. 

To access: Click the Statistics  button.

Ended Displays the start date for the request.

To access: Click the Similar Changes  button.

Impact Severity Indicates the impact severity level of the request.

To access: Click the Similar Changes  button.

Outcome Displays the outcome for the request. Requests with any 
status other than Closed are automatically assigned the 
outcome Not reviewed.

To access: Click the Similar Changes  button.

GUI Element (A-Z) Description
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Outcome pane Displays aggregate outcome statistics for all the requests 
in the Similar Changes list. 

To access: Click the Statistics  button.

Request ID Displays the reference ID number for the request in the 
service desk application.

To access: Click the Similar Changes  button.

Review Date Displays the date a Post Implementation Review (PIR) 
was created for the request. For more information on 
PIRs, see "Review > Conclusions Tab" on page 142.

To access: Click the Similar Changes  button.

Risk Displays a number from 0-100 that indicates the risk 
level of the request relative to other requests. A higher 
number indicates a higher risk level.

To access: Click the Similar Changes  button.

Summary Displays a brief overview of the request.

To access: Click the Similar Changes  button.

GUI Element (A-Z) Description
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Assess > Time Period Conflicts Tab

Conflicts Pane

Description Displays the time period conflicts in which the selected 
change request is scheduled to take place either outside 
of a Change Window (periods in which change requests 
are allowed to take place) or within a Blackout period 
(periods in which change requests are not allowed to take 
place).

For more information on how time period conflicts are 
calculated, see "Configuring Time Periods" in the 
HP Release Control Configuration Guide.

You can choose to display the time period occurrences in 
the background of the view, according to the category 
colors and time period patterns that were configured by 
the HP Release Control administrator.

To access: 

➤ In the Analysis and Details pane, click Assess > Time 
Period Conflicts tab.

or

➤ In the Analysis and Details pane, click 
Preview > Overview tab. In the Analysis Info pane, the 
displayed category for the Time Period Conflicts field 
serves as a link to the Time period Conflicts tab.

or

➤ In the Change Planner dialog box, click the Time 
Period Conflicts tab.

Important 
Information

If the selected change request has no planned start or end 
time, the buttons on the toolbar become unavailable and 
the grid inside the timeline disappears.

Included in Tasks "Define Time Periods" on page 51

Useful Links "Time Periods" on page 40

Description Displays the configured Change Window and/or 
Blackout periods that are the causes of the time period 
conflict.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Timeline Pane

GUI Element (A-Z) Description

Plan Selected Change. Enables you to simulate the effects 
of modifying the details of a change request. Opens the 
Change Planner dialog box. You can use the Change 
Planner dialog box to modify the planned start and/or 
end of the change request to avoid creating a time 
conflict, and then simulate the effects of the 
modifications.

Blackout. Denotes a period in which change requests are 
not allowed to take place.

Change Window. Denotes a period in which change 
requests are allowed to take place.

<Color of time 
period>

The color assigned to the time period category as defined 
by the HP Release Control administrator. This is the color 
that HP Release Control uses to display the category in 
the Analysis module.

Time Period The time period category defined by the HP Release 
Control administrator, with which the change request is 
conflicting.

Description Displays the occurrences of the time period conflict of 
the selected change request in a timeline.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Select Time Period. Displays a list of time period 
categories in which the request meets the criteria of the 
category’s selected filter. 

You can select the configured time periods you want to 
display in the background. By default, all the time 
periods are displayed.

For information on how to configure time periods, see 
"Configuring Time Periods" in the HP Release Control 
Configuration Guide.

Reset Time Line. Returns you to the start time of the 
selected change request. 

Now. Displays the current date.

Select a time frame over which to display the change 
requests. 

➤ Day. Displays the change requests for the selected date 
only.

➤ Week. Displays the change requests for the week 
surrounding the selected date.

➤ Month. Displays the change requests for the month 
surrounding the selected date.

By default, the time frame that appears depends on the 
duration and end time of the change request. 
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Select Date. Select the date you want to display. The 
calendar displays the week around the selected date.

Note: The latest date which HP Release Control enables 
you to navigate to in the calendar is whichever of the 
following is longer:

➤ The current date + 60 days

Note: The value 60 is the default which can be 
modified. For details on how to configure time 
periods, see "Configuring Time Periods" in the 
HP Release Control Configuration Guide.

or

➤ The planned end date of the selected change + 30 days

<Selected change 
request in the 
timeline>

The selected change request in the timeline is 
represented by a thick, black line.

<Selected date> Displays the selected date. The calendar displays the day, 
week, or month around the selected date, depending on 
which time frame was selected.

You can either use the Select Date  button, or 
alternatively, scroll through by clicking the left/right 
arrows.

GUI Element (A-Z) Description
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<Time period in the 
timeline>

The time period in the timeline is displayed in the color 
defined by the HP Release Control administrator. 

<Timeline> Displays the planned duration of the selected change 
request in a timeline as well as the time period categories 
to which the time period belongs.

GUI Element (A-Z) Description
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Change Planner Dialog Box

Description Enables you to simulate the effects of modifying the 
details of a change request.

You use the Change Planner to simulate the effects of 
modifying the following change request details:

➤ The planned start and end of the change request.

➤ The CIs that are changed as a result of the change 
request (CCIs).

Note: If you are using HP Service Manager as your service 
desk, you can save the updated planned start and end 
times of the change request to the service desk. 

To access: 

➤ In the Change Requests/Action Items pane, select 
View > Change Requests and then click  Plan 
Selected Change.

or

➤ In the Analysis and Details pane, click Assess > Time 
Period Conflicts and then click  Plan Selected 
Change.

Click the drop-down arrow next to the Change Planner 
button and select one of the following options:

➤ Plan Selected Change. The Change Planner opens, 
displaying the current details of the selected change 
request. Use this option to simulate changes to an 
existing change request.

➤ Plan New Change. The Change Planner opens without 
any current change request data. Use this option to 
simulate a new change. 

Included in Tasks "Use the Change Planner to Reschedule a Change" on 
page 50
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The following elements are included:

GUI Element (A-Z) Description

Run Simulation. Runs the change planner simulation.

Notes:

➤ The simulated results are displayed in the Change 
Planner details pane.

➤ If you are planning an existing change and you are 
satisfied with the results of the simulation, you can 
save the updated planned start and end times of the 
change request to the originating service desk. 

The save action is only available if you are using 
HP Service Manager as your service desk.

Save. Saves the updated planned times of the change 
request to your service desk.

Notes: 

➤ If you are simulating a new change, this option is not 
available. 

➤ Available only if you are using HP Service Manager as 
your service desk.

➤ If HP Release Control is not integrated with 
Lightweight Single Sign-On (LW-SSO), you are asked to 
fill in your HP Service Manager credentials.

Open the Original Request. Opens the Change Request in 
the originating service desk.

Notes: 

➤ If you are simulating a new change, this option is not 
available. 

➤ To enable this option, see "Generating Links to HP 
Service Manager/Center Tickets" in the HP Release 
Control Configuration Guide.
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Scheduling Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to set the planned start and end for the 
change request simulation. If you are working with 
HP Service Manager, you can save the updated times to 
your service desk.

GUI Element (A-Z) Description

Reset Time. Enables you to restore the currently planned 
times.

Get Suggested Time. Enables HP Release Control to 
suggest the next possible time for implementing the 
change, which is either within a Change Window and 
outside a Blackout period associated with the change 
request.

HP Release Control does not suggest a time in the 
following cases:

➤ If there is no time periods associated with the change

➤ If the change is within a Blackout period and there is 
no future Change Window

Scroll to the previous and next suggested times.

Note: These button appear only if HP Release Control has 
suggested another time. They are only enabled when 
there is more than one possible suggested time.

Accept Accept the time suggested by HP Release Control and run 
the change planner simulation according to the 
suggested time.

Note: Appears only if HP Release Control has suggested 
another time.

Cancel Restore the previous time.

Note: Appears only if HP Release Control has suggested 
another time.
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Change CIs Pane

Lock duration Enables you to lock the duration of the change. For 
example, if this option is selected and you modify the 
planned end time to 4 hours later, the planned start time 
is automatically adjusted to 4 hours later so that the 
duration of the change remains the same. 

Appears when this option is selected, that is, 
when the duration of the change is locked.

Appears when this option is not selected, that is, 
when the duration of the change is not locked.

Planned duration The difference in time between the start time and the end 
time of the change request.

Planned end Use the calendar to set the date and time for the planned 
end of the change request 

Note: If the change request does not include a planned 
end time, this box is empty.

Planned start Use the calendar to set the date and time for the planned 
start of the change request 

Note: If the change request does not include a planned 
start time, this box is empty.

Description Enables you to select the CIs (CCIs) that have changed as 
part of the change request simulation.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Reset CIs. Enables you to restore the current changed CIs.

Show Business CIs/System CIs. Toggles between 
displaying either Business CIs or System CIs.

Find. Search for a specific Business/System CI by entering 
the name or part of a name in the search box. The search 
returns all Business/System CIs that contain the entered 
string somewhere in the name.

Click the Find button to run the search.

<View other pages> To view other pages, use the left and right arrows. The 
number between the left and right arrows indicate which 
page is currently being displayed. For example, 3 of 5 
means that the 3rd page out of 5 is being displayed.

Available Business 
CIs/System CIs

Contains a list of the available Business/System CIs that 
can be used in the simulation. 

Select one or more of the required CIs (using the CTRL 
key) and then click the  top arrow to move them to 
the Selected CIs list. The selected CIs are included in the 
simulation.

Selected CIs Contains a list of the Business/System CIs to be included 
in the simulation.

Select one or more of the required CIs (using the CTRL 
key) and then click the  bottom arrow to move them 
to the Available Business CIs/System CIs list. The selected 
CIs are not included in the simulation.
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Preview Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Impact Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the current planned times of the change 
compared with the simulated times, as well as a summary 
of the current analysis results compared with the 
simulated analysis results.

GUI Element (A-Z) Description

Analysis Info Pane Displays a summary of the current analysis results 
compared with the simulated analysis results. For more 
information, see "Preview > Overview Tab" on page 134.

Time Window Info 
Pane

Displays the current planned times of the change 
compared with the simulated time.

Description Displays the impact analysis of the simulation.

Important 
Information

The information in this tab is presented in the same way 
as in the Analysis module’s Assess > Impact tab. For more 
information about viewing impact analysis results, see 
"Assess > Impact Tab" on page 67.

GUI Element (A-Z) Description

Enables you to view the current impact analysis or the 
simulated impact analysis and select the relevant option 
from the list.

Note: This option is relevant only if you are planning an 
existing change.
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Collisions Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the collision analysis of the simulation. 

Important 
Information

The information in this tab is presented in the same way 
as in the Analysis module’s Assess > Collisions tab. For 
more information about viewing collision analysis 
results, see "Assess > Collisions Tab" on page 70.

GUI Element (A-Z) Description

Enables you to filter the information displayed in the tab 
and select one of the following options from the list:

➤ Simulated Collisions. Displays all the collisions that 
occur when the simulated settings are applied. 

➤ Additional Collisions. Displays the additional 
collisions that occur as a result of the simulated 
settings. These collisions do not occur for the current 
settings.

➤ Unresolved Collisions. Displays the collisions that are 
common to both the current settings and the 
simulated settings. These collisions are not resolved as 
a result of the simulated settings.

➤ Resolved Collisions. Displays the collisions that are 
resolved as a result of the simulated settings. These 
collisions occur for the current settings and do not 
occur for the simulated settings.

Note: This option is relevant only if you are planning an 
existing change.
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Time Period Conflicts Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the time periods conflict analysis of the 
simulation.

Important 
Information

The information in this tab is presented in the same way 
as in the Analysis module’s Assess > Time Period 
Conflicts tab. For more information about viewing time 
period conflict analysis results, see "Assess > Time Period 
Conflicts Tab" on page 85.

GUI Element (A-Z) Description

Enables you to filter the information displayed in the tab 
and select one of the following options from the list:

➤ Current Time Conflicts. Displays all the time period 
conflicts for the currently displayed date.

➤ Simulated Time Conflicts. Displays all the time period 
conflicts that occur when the simulated settings are 
applied.

Note: This option is relevant only if you are planning an 
existing change.
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Risk Tab

Description Displays the risk analysis of the simulation. 

In the risk factor tables, in the Weighted Value column, 
for each risk factor that changed, the original weighted 
value is displayed in square brackets.

Important 
Information

➤ The information in this tab is presented in the same 
way as in the Analysis module’s Assess > Risk tab. For 
more information about viewing risk analysis results, 
see "Assess > Risk Tab" on page 78.

➤ This option is relevant only if you are planning an 
existing change.
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Change Requests — Calendar View

Description The Calendar view displays the change requests that 
have been processed by HP Release Control for each 
calendar day.

A single page displays one calendar week. Each column 
represents a calendar day and each cell represents a single 
change request. Change requests appear in ascending 
order according to their scheduled start times.

You can choose to display the configured time periods in 
the Calendar view. You do so by clicking the Select Time 
Periods button  and selecting the time period 
categories you want to view. The Calendar view displays 
these time periods alongside the dates on which they 
apply, using the Change Window  and Blackout  
icons. When you hold the mouse pointer over an icon, 
the name of the category to which the time period 
belongs as well as the period’s start and end times are 
listed in the tooltip.

To access: In the Change Requests/Action Items pane, 
select View > Change Requests and then click  
Calendar.

Important 
Information

➤ Change requests with no start or end times, or with 
start times later than their end times, do not appear in 
the Calendar view.

➤ The Calender view displays up to one hundred 
changes per calendar day. When a filter returns more 
than one hundred change requests per day, the 
Calendar view displays only the first one hundred. To 
view all the change requests, either refine the filter or 
switch to the List or Timeline view.

➤ By default, the calendar week begins on Monday and 
ends on Sunday and the color of each cell header 
indicates the impact severity level of the change 
request. To reconfigure these settings, see "Configuring 
Calendar Settings" in the HP Release Control 
Configuration Guide.
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Unless otherwise customized by the administrator, the following elements 
are included (unlabeled GUI elements are shown in angle brackets):

GUI Element (A-Z) Description

Collision severity Displays the collision severity level of the change request. 
If the change request collides with more than one other 
change request, the severity level for the worst collision is 
displayed.

Although the correlation of each severity level with a 
color-coded icon is configurable, by default the following 
color-coded icons (which also include symbols) indicate 
the following severity levels:

 Critical

 High

 Medium

 Low

 Very Low

For more information about collisions and how collision 
severity is calculated, see "Change Request Collisions" on 
page 41.
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Impact Severity Displays the impact severity level of the change request. 
The severity level for the change request is determined by 
the highest severity level of the configuration items 
affected by the request.

Although the correlation of each impact severity level 
with a color-coded icon is configurable, by default the 
following color-coded icons (which also include symbols) 
indicate the following impact severity levels:

 Critical

 High

 Medium

 Low

 Very low

 No impact analysis available

For more information about impact analysis and how 
impact severity is calculated, see "Assess > Impact Tab" on 
page 67.

GUI Element (A-Z) Description
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Request Type The request type icon indicates the following:

➤ The type of change request—that is, one of the 
following:

level 1 (by default, change) 

level 2 (by default, task) 

latent. Indicates that the change request was 
detected by HP Release Control.

A tooltip indicating the request type is visible when 
you hold the mouse pointer over this icon.

➤ Whether the request is scheduled to take place outside 
a Change Window period or within a Blackout period 
pertaining to the request. If so, a red exclamation 
point is included in the icon  . A tooltip lists the 
time period category with whose rules the request does 
not comply is visible when you hold the mouse 
pointer over this icon.

Note: The HP Release Control administrator configures 
time period categories and rules that apply to these 
categories. For more information, see "Configuring Time 
Period Settings" in the HP Release Control Configuration 
Guide.

The administrator can also configure the names of the 
change request types to reflect the terminology used in 
your integrated service desk application. For more 
information, see "Configuring Enumeration Field Display 
Settings" in the HP Release Control Configuration Guide.

User Discussion 
Threads & Posts

The presence of a user discussion threads & posts icon 
indicates that user discussion threads and comments 
exist in response to the selected change request. You can 
view the discussion threads themselves in the 
Collaboration tab’s Discussion view. For more 
information, see "Collaborate > Discussion Tab" on 
page 119.

GUI Element (A-Z) Description
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Change Requests — List View

Description The List view displays the change requests that have been 
processed by HP Release Control in the form of a sortable 
table. You can sort the order of appearance of the 
requests according to each column by clicking the 
appropriate column heading.

Parent requests (for example, changes) can be expanded 
to display all the child requests (for example, tasks). To 
expand or collapse parent requests, click the Expand  
button next to the request.

When you select a change request in the list, details and 
analysis information for the selected change request are 
displayed in the Details and Analysis pane.

Note: By default, the List view displays data for 20 
change requests. To reconfigure this number, see 
"Analysis Preferences Dialog Box" on page 28.

To access: In the Change Requests/Action Items pane, 
select View > Change Requests and then click  List.

Important 
Information

➤ You can filter the change requests displayed in the 
Change Requests mode. For details, see "Filtering 
Change Requests, Activities, and Action Items" on 
page 147.

By default, HP Release Control displays all the change 
requests in the system. When a filter is in place, it 
filters the change requests in all of the different views.

➤ You can customize the List view to display different 
information. For details on customizing the List view 
columns, see "Customizing the List View" in the 
HP Release Control Configuration Guide.
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Unless otherwise customized by the administrator, the following elements 
are included:

GUI Element (A-Z) Description

Collision Severity Displays an icon indicating the collision severity level of 
the change request. If the change request collides with 
more than one other change request, the severity level 
for the worst collision is displayed.

Although the correlation of each severity level with a 
color-coded icon is configurable, by default the following 
color-coded icons (which also include symbols) indicate 
the following severity levels:

 Critical

 High

 Medium

 Low

 Very Low

If there are no collisions with the change request, no 
collision severity icon is displayed.

A tooltip indicating the severity level of the collision is 
visible when you hold the mouse pointer over the 
collision severity icon.

For more information about collisions and how collision 
severity is calculated, see "Change Request Collisions" on 
page 41.

Contact Person Displays the name of the user responsible for the change 
request.
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Impact Severity Displays an icon indicating the impact severity level of 
the change request. The severity level for the change 
request is determined by the highest severity level of the 
configuration items affected by the request.

Although the correlation of each impact severity level 
with a color-coded icon is configurable, by default the 
following color-coded icons (which also include symbols) 
indicate the following impact severity levels:

 Critical

 High

 Medium

 Low

 Very low

 No impact analysis available

A tooltip indicating the impact severity level of the 
change request is visible when you hold the mouse 
pointer over the severity level icon.

For more information about impact analysis and how 
impact severity is calculated, see "Impact Analysis" on 
page 35.

Priority Displays the HP Release Control priority level of the 
change request. When you configure HP Release Control, 
you configure the priority levels that can be assigned to a 
change request.

Request ID Displays the reference ID number of the change request 
in the service desk application.

GUI Element (A-Z) Description
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Risk Displays a number from 0-100 that indicates the risk 
level of the selected change request relative to the other 
change requests. A higher number indicates a higher risk 
level. 

Next to the number is a risk level (low, medium, or high). 
These levels can be manually configured to correspond to 
different numeric risk levels.

HP Release Control calculates this figure based on risk 
factors that are subjectively weighted by the HP Release 
Control administrator during the configuration process. 
For more information about how the risk level is 
calculated, see "Risk Analysis" on page 36.

Start Displays the date on which the change request is 
scheduled to begin.

Status Displays the HP Release Control status of the change 
request. When you configure HP Release Control, you 
configure the statuses that can be assigned to a change 
request.

GUI Element (A-Z) Description
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Summary Displays a brief overview of the change request. 

The icon next to the overview sentence indicates the 
following:

➤ The type of change request—that is, one of the 
following:

level 1 (by default, change) 

level 2 (by default, task) 

latent. Indicates that the change request was 
detected by HP Release Control.

A tooltip indicating the request type is visible when 
you hold the mouse pointer over this icon.

➤ Whether the request is scheduled to take place outside 
a Change Window period or within a Blackout period 
pertaining to the request. If so, a red exclamation 
point is included in the icon . A tooltip lists the 
time period category with which the rules the request 
does not comply is visible when you hold the mouse 
pointer over this icon.

Note: The HP Release Control administrator configures 
time period categories and rules that apply to these 
categories. For more information, see "Configuring Time 
Period Settings" in the HP Release Control Configuration 
Guide. The administrator can also configure the names of 
the change request types to reflect the terminology used 
in your integrated service desk application. For more 
information, see "Configuring Enumeration Field Display 
Settings" in the HP Release Control Configuration Guide.

User Discussion 
Threads & Posts

The presence of a user discussion threads & posts icon 
indicates that user discussion threads and comments to 
these threads exist in response to the selected change 
request. A tooltip indicating how many discussion 
threads and comments exist is visible when you hold the 
mouse pointer over this icon. 

You can view the discussion threads themselves in the 
Collaboration tab’s Discussion view. For details, see 
"Collaborate > Discussion Tab" on page 119.

GUI Element (A-Z) Description
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Change Requests — Timeline View 

Description The Timeline view displays the change requests that have 
been processed by HP Release Control in the form of a 
timeline. It display the change requests, implementors, 
and business CIs in the context of their schedules. 

The Change Requests mode’s Timeline view displays data 
as blocks of time on a timeline. Each entry is displayed 
on a separate row. 

The Timeline view resembles a typical Gantt chart, 
allowing you to view overlapping change requests.

When you hold the cursor over different items in the 
Timeline view, a tooltip appears displaying detailed 
information about those items. When you click a row 
entry, details and analysis information are displayed in 
the Details and Analysis pane. For details, see "Details 
and Analysis Pane" on page 126.

You can choose one of the following view types:

➤ Change requests

➤ Business CIs

➤ Implementors

To access: In the Change Requests/Action Items pane, 
select View > Change Requests, click  List and then 
choose the required view type.

Important 
Information

When filtering Timeline views, the Change requests, 
Business CIs, and Implementors views all display the 
results as defined by the filtering mechanism. But, in the 
Business CI and Implementor Timeline views, the 
filtering results only include results that are applicable to 
that group. For example, a change request that does not 
affect any CI is not displayed in the timeline group of 
business CIs.

For details on working with filters, see "Filtering Change 
Requests, Activities, and Action Items" on page 147.
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Unless otherwise customized by the administrator, the following elements 
are included:

GUI Element (A-Z) Description

Business CI view Each row displays the change request for a single 
business CI. Change requests that overlap are indicated 
by a darker shade at the point at which they overlap.

You can display all of the change requests associated with 
a single business CI by clicking the arrow next to the 
relevant business CI.

Change Request view Displays change requests, where each change request is 
displayed on a separate row.

Impact Severity 
Levels

Displays the impact severity level of the change request, 
indicated by the color of the block. The severity level for 
the change request is determined by the highest severity 
level of the configuration items affected by the change 
request.

By default, the following colors indicate the following 
impact severity levels:

➤ Red - Critical

➤ Orange - High

➤ Yellow - Medium

➤ Khaki - Low

➤ Olive Green - Very Low

➤ Gray - No impact analysis available

Note: For more information about impact analysis and 
how impact severity is calculated, see "Impact Analysis" 
on page 35.
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Implementor view Each row displays the change request for a single 
implementor. Change requests that overlap are indicated 
by a darker shade at the point at which they overlap.

You can display all of the change requests associated with 
an implementor by clicking the arrow next to the 
implementor name. 

Time period-related 
data

Indicates whether the change request is scheduled to be 
executed within one of the configured Change Window 
periods pertaining to the request.

The color of the block frame can be one of the following:

➤ A white frame indicates that the change request is 
scheduled to take place during one of the Change 
Window periods that is configured for a time period 
category in which the selected change request is 
included.

➤ A black frame indicates that there is a time period 
conflict and the change request falls either outside a 
Change Window period or within a Blackout period 
configured for a time period category in which the 
selected change request is included. The name of the 
time period category and the name of the recurrence 
rule that is breached are indicated in the change 
request’s tooltip.

You can choose to display the time periods themselves 
in the background of the view, according to the 
category colors and time period patterns that were 
configured by the HP Release Control administrator. 
You do so by clicking the Select Time Period  
button and selecting the categories you want to view 
in the background.

GUI Element (A-Z) Description
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Change Requests Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays change requests that have been processed by 
HP Release Control. You can analyze the change requests 
from a number of different perspectives by selecting one 
of the following views:

➤ List. Displays change requests in list format. For 
details, see the "Change Requests — List View" on 
page 103.

➤ Calendar. Displays the change requests in calendar 
format. For details, see the "Change Requests — 
Calendar View" on page 99.

➤ Timeline. Displays the change requests in timeline 
format. For details, see the "Change Requests — 
Timeline View" on page 108.

To access: In the Change Requests/Action Items pane, 
select View > Change Requests.

Important 
Information

You can filter the change requests displayed in the 
Change Requests mode. For details, see "Filtering Change 
Requests, Activities, and Action Items" on page 147.

By default, HP Release Control displays all the change 
requests in the system. When a filter is in place, it filters 
the change requests in all of the different views.

Useful Links "Action Items" on page 34

GUI Element (A-Z) Description

List. Displays the Change Requests in a list format. Opens 
the Change Requests — List View.

Calendar. Displays the Change Requests in a calendar 
format. Opens the Change Requests — Calendar View.
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Timeline. Displays the Change Requests in a timeline 
format. 

Click the drop-down arrow and select one of the 
following options:

➤ Group by Change Request.

➤ Group by Business CI.

➤ Group by Business CI.

Opens the Change Requests — Timeline View.

Plan Selected Change. Enables you to simulate the effects 
of modifying the details of a change request and to view 
how these modifications influence the analysis data.

Click the drop-down arrow and select one of the 
following options:

➤ Plan Selected Change.

➤ Plan New Change.

Opens the Change Planner. 

New Discussion Thread. Enables you to add a new thread 
to the discussion in the Votes pane in the 
Collaborate > Discussion tab. Opens the New Discussion 
Thread dialog box.

New Action Item. Used to create an action item 
associated with the request. Opens the Add Action Item 
dialog box.

Generate Report. Enables you to generate a PDF, an 
HTML report, or an Excel report. Opens the Report 
Details dialog box.

Note: Appears only in the List and Calendar views.

GUI Element (A-Z) Description
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Send by E-mail. Enables you to send discussion threads 
by email.

Click the drop-down arrow and select one of the 
following options:

➤ Send Change data. Send an email containing only the 
selected change request.

➤ Send Change data and log. Send an email containing 
the selected change request as well as the event log 
information associated with it.

➤ Send CAB invitation. Send an invitation to the CAB 
meeting.

➤ Send CAB minutes. Send the CAB minutes of the 
selected change.

➤ Send PIR invitation. Send an invitation to the PIR 
meeting.

➤ Send PIR minutes. Send the PIR minutes of the 
selected change.

Add Selected Request to Favorites/ Delete Selected 
Request from Favorites. Toggles between adding or 
removing the selected change request from the Favorites 
filter. For details, see "Filtering Change Requests, 
Activities, and Action Items" on page 147.

Click the drop-down arrow and select one of the 
following options:

➤ Delete from Favorites. Deletes the selected change 
request from the Favorites filter.

➤ Delete all AI's in the Favorites Filter. Deletes all the 
change requests in the Favorites filter.

Note: You can also subscribe to receive notifications 
when certain modifications are made to favorite change 
requests. For details, see "Analysis Preferences Dialog Box" 
on page 28.

GUI Element (A-Z) Description
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Subscribe to Selected Request/Unsubscribe from 
Selected Request. Enables you to receive email 
notifications or cancel a notification subscription for the 
selected change request. For information on configuring 
notification rules and conditions, see "Configuring 
Notifications" in the HP Release Control Configuration 
Guide.

Go to Parent Request. Displays the parent change 
request for the selected child change request (task). 

Note: Appears only in the List view.

Zoom in/Zoom out. Enables you to select the required 
focus time range.

Note: Appears only in the Timeline view.

Select Time Period. Enables you to select the configured 
time periods to display in the background of the 
Timeline and Calendar views.

For information on how to configure time periods, see 
"Configuring Time Periods" in the HP Release Control 
Configuration Guide.

Note: Appears only in the Calendar and Timeline views.

Now. Display the current date.

Note: Appears only in the Calendar and Timeline views. 

Select a time frame over which to display the change 
requests. Following are the options:

➤ Day. Displays the change requests for the selected date 
only.

➤ Week. Displays the change requests for the week 
surrounding the selected date.

➤ Month. (Default) Displays the change requests for the 
month surrounding the selected date.

Note: Appears enabled only in Timeline mode.

GUI Element (A-Z) Description
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Select Date. Select the date you want to display. The 
calendar displays the week around the selected date.

Note: Appears only in the Calendar and Timeline views. 

<Display the selected 
date>

Displays the selected date. The calendar displays the 
week around the selected date.

You can either use the Select Date  button, or 
alternatively, scroll through the weeks by clicking the 
left/right arrows.

Note: Appears only in the Calendar and Timeline views. 

<View other pages> To view other pages, use the left and right arrows. The 
number between the left and right arrows indicate which 
page is currently being displayed. For example, 3 of 5 
means that the 3rd page out of 5 is being displayed.

Note: Appears only in the List view.

GUI Element (A-Z) Description
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Change Requests/Action Items Pane

Description Displays a list of change requests or action items, 
depending on the mode that you select.

You use the View box in the top left-hand corner of the 
Analysis module to switch between the following two 
modes:

➤ Change Requests mode. Displays change requests that 
have been processed by HP Release Control. You can 
analyze the change requests from a number of 
different perspectives by selecting one of the following 
available views: List, Calendar, or Timeline. For 
detailed information on each of these views, see the 
"Change Requests Pane" on page 111.

➤ Action Items mode. Displays action items that have 
been created from change requests as well as the basic 
information and user comments for each action item 
selected from the list. 

For details, see the "Action Items Pane" on page 56.

To access: Select Module > Analysis > View > Change 
Requests/Action Items.

Important 
Information

For information on using the filter mechanism to display 
only those action items that meet certain criteria, see 
"Filtering Change Requests, Activities, and Action Items" 
on page 147.

Useful Links "Action Items" on page 34
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Navigate between the Change Request and Action Item 
modes, and their filter selections. For more details, see 
"Filtering Change Requests, Activities, and Action Items" 
on page 147.

Search for Request/Action Item ID. Locate a required 
change request or action item.

➤ In the Change Request pane, enter a search request ID 
in the Search for Change Request box to locate the 
required changed request in the list of change 
requests.

➤ In the Action Item pane, enter an action item ID in 
the Search for Action Item box to locate the required 
action item in the list of action items.

Refresh. Enables you to refresh the change requests 
displayed in the Change Requests pane or the action 
items displayed in the Action Items List pane.

Change Requests/
Action Items

Enables you to filter change requests and action items. 

Results The number of change requests or action items that meet 
the set of criteria you defined.

View Enables you to switch between the Change Request and 
Action Item mode.
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Collaborate > Action Items Tab

Action Items Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Action Item Postings Pane

Description Enables you to view the change request’s action items.

➤ If you are in Change Requests mode, this tab enables 
you to view the action items associated with a change 
request and work with these action items as you would 
in the Action Items pane of the Action Items mode. 

➤ If you are in Action Items mode, this tab enables you 
to view all the action items associated with the same 
change request as the selected action item.

To access: In the Analysis and Details pane, click 
Collaborate > Action Items tab.

Useful Links "Action Items" on page 34

Description Displays the action items associated with a change 
request. For information on this pane, see "Action Items 
Pane" on page 56.

GUI Element (A-Z) Description

Displays the selected action item in the Action Items 
pane.

Description Displays information for each action item selected from 
the list. For information on this pane, see "Action Items 
Pane" on page 56.
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Collaborate > Discussion Tab

Comments Pane

The following elements are included:

Description Displays the discussion threads and comments as well as 
a summary of the votes pertaining to the selected or 
associated change request. This tab enables users to 
conduct online discussions about a change request prior 
to the CAB actually meeting to discuss it. As a result, the 
CAB discussion can begin at a more advanced stage or 
may not be necessary at all if it is clear from the user 
responses whether or not the change request should be 
approved.

To access: In the Analysis and Details pane, click the 
Collaborate > Discussion tab.

Description Displays all the discussion threads pertaining to the 
change request. Each thread includes a heading with the 
name of the user who initiated the discussion, an icon 
representing the vote posted by the discussion initiator, 
the date and time of the initial comment, the subject and 
text of the initial comment, and the comments posted by 
other users to the thread.

GUI Element (A-Z) Description

Expand All Comments. Enables you to expand all the 
comments included in the discussion threads.

Collapse All Comments. Enables you to collapse all the 
comments included in the discussion threads.

Older First / Newer First. Enables you to sort the 
comments to either display the oldest comment first or 
the newest comment first.
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Votes Pane

New Discussion Thread. Enables you to add a thread to 
any change request. Opens the New Discussion Thread 
dialog box.

Send E-Mail. Enables you to send one or more discussion 
threads by email. Opens the Send Email dialog box 
opens. 

Enter the email address of each recipient of the email and 
any additional comments you have on the change 
request.

Description Displays a summary of the most recent votes posted by 
discussion initiators for the change request. 

GUI Element (A-Z) Description
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The following element is included:

Collaborate > Resolution Tab

GUI Element (A-Z) Description

<Voting summary 
tree>

Displays the most recent votes posted by discussion 
initiators for the change request. Each available voting 
option is displayed (Disagree, Agree, To CAB, and No 
Vote) with the number of users who voted for that option 
displayed in parentheses.

Note: Only the user’s most recent vote is taken into 
account.

Under each voting option, a list of users (discussion 
initiators) who voted for that option is displayed. You 
can expand or collapse the list of users under each voting 
option by clicking the arrow next to the voting option.

When you select a user, all the discussion threads 
initiated by that user are displayed in the Comments 
pane. To view all the discussion threads initiated by all 
the users in the Comments pane, click All. To sort the 
discussion threads chronologically, click the Older First/
Newer First  button.

Note: Users can initiate more than one discussion thread 
for each change request. All discussion threads are 
displayed along with the user’s most recent vote.

Description Enables you to approve a change request or retract the 
approval, view approval history and status, and create 
CAB minutes and as pre- and post-implementation 
guidelines.

To access: In the Analysis and Details pane, click 
Collaborate > Resolution tab.
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Change Approval Pane

Description Enables you to approve a change request or retract the 
approval, and view approval history and status.

The approve and retract options depend on the status of 
the request, and is only available if you are a user with 
the role of Change Approver.

The approval/retraction of a change request within 
HP Release Control results in an updated status of the 
request within the service desk application. If you are 
using HP Service Manager, the approval comments are 
also exported along with the updated status.

This feature enables you to manage the request approval 
process from HP Release Control, without having to 
directly access each request from within the service desk 
application.

To check whether your service desk application supports 
the approval/retraction feature, contact customer 
support.

Important 
Information

When you approve a change request, HP Release Control 
checks whether your user name and password are correct 
and whether you are currently allowed to approve the 
change request. If so, HP Release Control approves the 
request and the approval details appear in the 
Collaborate tab.

If the authentication data you provided is incorrect, or if 
you are not currently allowed to approve the change 
request, HP Release Control issues a detailed error 
message. If the service desk application’s version of the 
request is more current than the version in HP Release 
Control, you receive a message asking whether you want 
to force the approval of the change request. Select the 
check box and click Approve to force approval.
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The following elements are included:

GUI Element (A-Z) Description

Approval Log. Displays a history of approvals and 
retractions made in HP Release Control for the selected 
change. The users who approved the change request or 
retracted approval are listed, along with comments that 
they posted.

Approval Status. If you are using HP Service Manager/
Center as your service desk, you can view the approval 
status of the selected change

The Change Approval pane is divided into three approval 
categories. Each category lists the relevant user groups 
(for example, Admin).

The following three approval categories are displayed:

➤ Completed Approvals. Lists the user groups who have 
already approved the change.

➤ Pending Approvals. Lists the user groups whose 
approval is still required.

➤ Future Approvals. List the user groups who can only 
approve a change after a different user group has 
already approved it. The user groups that need to first 
approve the change, are listed in the Pending 
Approvals category. 

For more information about configuring these options, 
see "Configuring HP Service Manager/Center" in the 
HP Release Control Configuration Guide.
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Approve. Enables you to approve a change request. 
Opens the Approve Change Request dialog box.

Retract. Enables you to retract the approval you gave for 
the selected request. Opens the Retract Change Request 
dialog box.

For more information about approving or retracting a 
change request, see "Approve/Retract Change Request 
Dialog Box" on page 66.

When you select the relevant change request, or action 
item in the Change Requests or Action Items pane, and 
then select the Collaborate > Resolution tab, the 
Checking status message is displayed as the tooltip for the 
Approve and Retract buttons while HP Release Control 
checks the following:

➤ Whether you are a user with the role of Change 
Approver who is authorized to approve change 
requests.

➤ Whether request approval is authorized by the service 
desk application.

➤ Whether the selected change request can be approved 
at the current time.

If all the above criteria are met, the Approve button is 
enabled. If request approval is not authorized by the 
service desk application, an Operation not supported 
status message is displayed as a tooltip for Approve and 
Retract buttons.

If the change request was recently approved and its status 
has not yet been updated in HP Release Control, an 
Approved status message is displayed as the tooltip for 
the Approve button.

If an error occurred during the HP Release Control 
verification process, an error message is displayed as the 
tooltip for the Approve and Retract buttons.

GUI Element (A-Z) Description
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CAB Decisions Pane

The following element is included:

Description Enables you to post different types of notes regarding the 
approval/retraction process.

Important 
Information

To perform this procedure, you must be a user with the 
role of Change Manager.

GUI Element (A-Z) Description

Add Decision. Enables you to post different types of notes 
regarding the approval/retraction process. Opens a dialog 
box in which you can select the type of note you want to 
post:

➤ CAB Minutes. Details of relevant CAB discussions.

➤ Pre-Implementation Guidelines. Guidelines to follow 
before implementing a change. These guidelines 
appear in the director module in the alerts pane before 
a change request is scheduled.

➤ Post-Implementation Guidelines. Follow-up 
procedures after implementing a change. These 
guidelines appear in the director module in the alerts 
pane after a change request is scheduled.

Enter the subject and content of the note in the dialog 
box that appears. The note appears in the CAB Decisions 
pane.
125



Chapter 4 • Analysis Module
Details and Analysis Pane

Description Displays the same information for the Change Requests 
and Action Items modes. If you are working with the 
Change Requests mode, the Details and Analysis pane 
displays information for each selected change request. If 
you are working with the Action Items mode, the Details 
and Analysis pane displays information for the change 
request associated with each selected action item.

The Details and Analysis pane contains the following 
tabs:

➤ Preview. Provides a general Overview of the 
information pertaining to the selected or associated 
change request, and the change request Details that 
originate from the service desk application.

➤ Assess. Displays the analysis data for the selected or 
associated change request.

➤ Collaborate. Displays the Discussion threads 
pertaining to the selected or associated change 
request, and the Action Items associated with the 
request. In addition, you can use the Resolution view 
in this tab to participate in CAB discussions, or to 
approve or retract a request, depending on the status 
of the request, if you have been granted Approver 
status in HP Release Control.

➤ Review. Displays the outcome of the selected or 
associated change request following the 
implementation of the request, the comments entered 
by the change reviewer, and a list of business CIs that 
were negatively affected by the implementation of the 
request.

To access: Select Module > Analysis.

Important 
Information

If you are working with the Change Requests mode, the 
tabs display information for each selected change 
request. If you are working with the Action Items mode, 
the tabs display information for the change request 
associated with each selected action item.
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Impact Graph Window

The following elements are included:

Description Displays a visual representation of the impact 
relationships of the selected change request.

You can manipulate the display by dragging and 
dropping individual CIs. The lines, arrows, and 
relationships are not affected.

Impact graphs for individual CIs or groups of CIs can be 
viewed by selecting the CI or CI group while in the 
impact graph window.

To access: Click Open Graph Window  in the 
Assess > Impact tab.

GUI Element (A-Z) Description

Root Node. Returns the Impact Graph window to the 
original display if an impact graph for individual CIs or 
groups of CIs is the current view.

Concentric Radial Layout. Reorganizes the CIs in 
concentric radial layout.

Hierarchy Layout. Reorganizes the CIs in hierarchy 
layout.

Parent-Centered Radial Layout. Reorganizes the CIs in 
Parent-Centered Radial Layout.

Spring Forced Layout. Reorganizes the CIs in Spring 
Forced Layout

Zoom. Enables you to change the magnification by 
zooming in or out.
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New Discussion Thread Dialog Box

All Impact CIs Affect Displays a visual representation of the impact 
relationships in graphic format.

The CIs are connected by lines with arrows indicating the 
direction of impact. For example, if a CI named host11 
has an arrow pointing to serverB, it means that host11 
affects serverB.

You can customize the impact graph layout to reorganize 
the CIs while still maintaining the same impact 
relationships.

Impact CIs Displays the affected and changed CIs (ACIs and CCIs). 

Description Enables you to add a discussion thread to any change 
request. As part of the discussion thread, you can express 
an opinion about the change by selecting the required 
voting option.

You can add more than one discussion thread for each 
change request. All discussion threads along with the 
user’s most recent vote are displayed in the 
Collaborate > Discussion tab.

To access from the Change Requests pane: In the 
Change Requests/Action Items pane, select View > 
Change Requests. and then click  New Discussion 
Thread.

To access from the Analysis and Details pane: Click 
Collaborate > Discussion tab, and then click  New 
Discussion Thread.

Useful Links "Collaborate > Discussion Tab" on page 119

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Post Implementation Review Dialog Box

GUI Element (A-Z) Description

<Message box> (Optional) Type the required message.

Subject Type the required subject. 

Voting Select one of the following voting options. 

➤ Disagree

➤ To CAB

➤ Agree

➤ No Vote

If you voted on this change request before, your most 
recent vote is displayed as the Current vote on the 
right-hand side of the dialog box.

Description Enables you to create/edit a PIR for a change request. 

The PIR is added to the change request and all submitted 
PIR information appears in the Conclusions Information 
pane of the Review > Conclusions tab.

To access: In the Details and Analysis pane, click the 
Review > Conclusions tab, and then click Review  in 
the Conclusion Information pane.

Important 
Information

➤ By default, HP Release Control enables you to create a 
PIR for a change request only with an Evaluation and 
Closure status.

➤ If you are working with HP Service Manager, 
HP Release Control updates the PIR information 
directly to that application.

Useful Links "Review > Conclusions Tab" on page 142
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Details Tab

The following elements are included:

Disrupted Business CIs

Description Enables you to create/edit a PIR for the selected change 
request.

GUI Element (A-Z) Description

Change outcome Select the change request’s outcome from the drop-down 
list.

Customer 
satisfaction

The customer is the person who opened the request 
ticket in the service desk application. Select the overall 
level of customer satisfaction for the request from the 
drop-down list.

Planning satisfaction Select the overall level of planning satisfaction for the 
request from the drop down list.

Review comments Add any comments that may be relevant.

Review date Use the calendar to set the date and time for the review 
creation. The date and time of the first PIR creation is 
saved in the system. If you are editing a PIR, we 
recommend that you do not change this.

Service desk 
authentication

If you are working with HP Service Manager, enter your 
user name and password to update the PIR information 
directly to that application. This field does not appear if 
you are using any other service desk application.

Description Displays the business CIs that are included in the PIR.

The business CIs you include in the PIR appear in the 
Disrupted Business CIs pane of the Review > Conclusions 
tab.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Show only impacted business CIs/Show all business CIs.

Toggles between displaying:

➤ A list of all business CIs that are impacted by the 
current request (Show only impacted business CIs). 

➤ A list of all the relevant business CIs that HP Release 
Control recognizes in the HP Universal CMDB (Show 
all business CIs).

Show Obsolete. View the obsolete business CIs.

Find. Search for a specific business CI in the Available 
Business CIs list by entering the name or part of a name 
in the search box. The search returns all business CIs that 
contain the entered string somewhere in the name.

Click the Find button to run the search.

<View other pages> To view other pages, use the left and right arrows. The 
number between the left and right arrows indicate which 
page is currently being displayed. For example, 3 of 5 
means that the 3rd page out of 5 is being displayed.
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Preview > Details Tab

Unless otherwise customized by the administrator, the following elements 
are included:

Available Business CIs Contains a list of the available business CIs that are either 
impacted by the current request or business CIs that 
HP Release Control recognizes in the HP Universal 
CMDB. 

To include one or more of the business CIs in the PIR, 
select the required CIs (using the CTRL key), and then 
click the  top arrow to move them to the Disrupted 
Business CIs list.

Disrupted Business 
CIs

Contains a list of the business CIs to be included PIR.

To remove one or more of the business CIs from the PIR, 
select required CIs (using the CTRL key) and then click 
the  bottom arrow to move them to the Available 
Business CIs list.

Description Displays the change request details that originate from 
the service desk application and some key analysis data 
processed by HP Release Control.

To access: In the Analysis and Details pane, click the 
Preview > Details tab.

Important 
Information

For details on customizing the Preview > Details tab, 
see "Customizing the Preview > Details Tab" in the 
HP Release Control Configuration Guide.

GUI Element (A-Z) Description

Actual end The time at which execution of the change request 
actually ended.

Actual start The time at which execution of the change request 
actually began.

GUI Element (A-Z) Description
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Category The category describing the type of change request.

Contact person The name of the user responsible for the change request.

Contact location The geographic location of the person responsible for the 
change request.

Created The time at which the change request was originally 
created in the service desk application.

Emergency Indicates that the change request is handled according to 
the Emergency Change procedure.

Estimated risk The estimated risk level that was assigned to the change 
request by a user.

Impact severity The HP Release Control-calculated impact severity level 
of the change request. For more details about impact 
severity, see "Impact Analysis" on page 35.

Implementors The people responsible for implementing the change 
request.

Initiated by The person initiating the request (first level change 
requests only).

Last impact analysis The time at which an impact analysis was last calculated.

Last updated The time at which the change request was last updated in 
the service desk application.

Opened by The person initiating the request (second level change 
requests only).

Planned end The time at which the execution of the change request is 
scheduled to end.

Planned start The time at which the execution of the change request is 
scheduled to begin.

Priority The HP Release Control priority level of the change 
request. When you configure HP Release Control, you 
configure the priority levels that can be assigned to a 
change request.

GUI Element (A-Z) Description
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Preview > Overview Tab

Request ID The reference ID number of the change request in the 
service desk application.

Requested end date The latest date by which to implement the request.

Risk analysis Displays a number between 0-100, calculated by 
HP Release Control, that indicates the risk level of this 
change request relative to the other change requests. For 
more information about how the risk level is calculated, 
see "Risk Analysis" on page 36.

Scheduled downtime 
start

The change activity's planned downtime start time.

Service desk The service desk application in which the change request 
originated.

Subcategory Elaborates on the category field, and describes the type 
of change request in further detail.

Urgency The urgency assigned to the request by the request 
initiator.

Description Displays a summary of the change request information 
received from the service desk application.

To access: In the Analysis and Details pane, click the 
Preview > Overview tab.

GUI Element (A-Z) Description
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The following elements are included:

GUI Element (A-Z) Description

Analysis Info Displays a summary of the change analysis performed by 
HP Release Control for the change request and includes 
the following data:

➤ Impact severity. Displays the impact severity level of 
the change request as represented by the impact 
severity icon. A tooltip indicating the impact severity 
level of the change request is visible when you hold 
your mouse over the icon. The icon serves as a link to 
the Impact Analysis tab. 

For more information about impact analysis and how 
impact severity is calculated, see "Impact Analysis" on 
page 35.

➤ Collisions. Displays the collision severity level of the 
change request as represented by the collision severity 
icon. If the change request collides with more than 
one other change request, the severity level for the 
worst collision is displayed. A tooltip indicating the 
severity level of the collision is visible when you hold 
your mouse over the icon. The icon serves as a link to 
the Collisions tab. 

For more information about collisions and how 
collision severity is calculated, see "Change Request 
Collisions" on page 41.

➤ Risk. Displays a number from 0-100 that indicates the 
risk level of this change request relative to the other 
change requests. A higher number indicates a higher 
risk level. The displayed number serves as a link to the 
Risk tab. 

For more information about how the risk level is 
calculated, see "Risk Analysis" on page 36.
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GUI Element (A-Z) Description

Analysis Info (con’t) ➤ Changed CIs. Displays the number of CIs that were 
changed as a direct result of the change request. The 
displayed number serves as a link to the Impact 
Analysis tab.

➤ Affected business CIs. Displays the number of business 
CIs that were affected as a result of the change request. 
The displayed number serves as a link to the Impact 
Analysis tab. 

➤ Time period conflicts. If the change request breached 
the recurrence rules of a time period category, the 
name of the category is displayed. The displayed 
category serves as a link to the Assess > Time Period 
Conflicts tab.
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General Info ➤ Request ID. The reference ID number of the change 
request in the service desk application.

➤ Service desk. The service desk application from which 
the change request originated.

➤ Scheduled for. The scheduled start time of the change 
request.

➤ Duration. The scheduled duration of the change 
request.

➤ Status. The status of the change request as defined in 
the service desk application.

➤ Outcome. The outcome of the change request. The 
outcome is submitted in the Review tab. The Outcome 
value links to the Review > Conclusion tab.

User Info ➤ Discussion threads. The number of discussion threads 
posted by users in response to the change request.

➤ Disagree. The number of users who posted the vote 
Disagree in response to the change request.

➤ To CAB. The number of users who posted the vote To 
CAB in response to the change request.

➤ Agree. The number of users who posted the vote 
Agree in response to the change request.

Note: The data links to the Collaborate > Discussion tab. 
For details, see "Collaborate > Discussion Tab" on 
page 119.

GUI Element (A-Z) Description
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Report Details Dialog Box

Description Enables you to generate a PDF, an HTML, or an Excel 
report that contains data for a single change request, all 
the change requests displayed on the current page, or all 
the change requests included in the current filter. Opens 
the Report Details dialog box.

To access: In the Change Requests/Action Items pane, 
select View > Change Requests. In either the List or 
Calendar view, select the change request, page, or filter 
for which you want to create a report and click  
Generate Report.

Important 
Information

If you are working in an Asian language environment 
and want to generate PDF reports, you must modify the 
PDF encoding value (currently defined as CP1250) within 
the following report template files, located in the 
<HP Release Control installation 
directory>\conf\reports.ext directory: 

➤ calendar.changes-report.days-subreport.pdf.jrxml

➤ calendar.changes-report.pdf.jrxml

➤ calendar.changes-report.tickets-subreport.pdf.jrxml

➤ grid.change-single-pager-report.pdf.jrxml

➤ grid.changes-report.pdf.jrxml

➤ grid.changes-report.tasks-subreport.pdf.jrxml

Useful Links For information on customizing reports, see 
"Customizing Reports" in the HP Release Control 
Configuration Guide.
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The following elements are included:

GUI Element (A-Z) Description

Level Policy Enables you to define whether you want to include child 
change requests (tasks) as well as parent change requests 
(changes) in the report.

Select:

➤ Collapsed, to include data for parent change requests 
(changes) only.

➤ Expanded, to include child change requests (tasks) as 
well as parent change requests (changes) in the report.

Note: Collapsed is the default value.

Output type Select the required report output type. The options are:

➤ PDF

➤ Excel 

Note: The Excel option only appears when you select 
List as your Request Layout option.

➤ HTML

Request layout Choose the required request layout option:

➤ One page. Displays the data for each change request 
on a separate page. 

Note: The One page option only appears in List view 
mode.

➤ List. Displays the data for each change request 
concisely, in a list format. Several lists are displayed on 
each page.

Request range Depending on the data you want to view in the report, 
choose the required request range. The options are:

➤ Selected change request

➤ Current page

➤ Current filter
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Respond Dialog Box

The following elements are included:

Description Enables:

➤ Any HP Release Control user can add a comment to 
any action item that is not closed.

➤ The assignee of an action item to return the action 
item to its creator, if, for any reason he/she does not 
want to accept it.

➤ The assignee of an action item to change the status of 
an action item from Open to Done.

➤ The creator of an action item to change the status of 
an action item from Open or Done to Closed.

To access: In the Change Requests/Action Items pane, 
select View > Action Items. In the Action Items pane, 
select the required action item and click .

Important 
Information

The  button is enabled only when the 
action item selected is assigned to the current user.

GUI Element (A-Z) Description

Description ➤ If you have selected Post and pend the action item on 
<creator>, enter the reason why you do not want to 
accept the action item.

➤ If you have selected Respond with a post, enter the 
full text of your comment.

Inform <creator> 
that the action item 
is done

Enables the assignee to change the status of an action 
item from Open to Done. 

For details about the statuses of action items, see "Status" 
on page 61.

Note: This option appears when the selected action item 
is assigned to the current user and does not yet have a 
Done status.
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Post and pend the 
action item on 
<creator>

Enables you, as the assignee, to return the action item to 
its creator if for any reason you do not want to accept it. 
Send it back to: <creator> appears in the Subject box.

Note: Your action is now listed as a comment in both the 
Action Items List pane and the Collaboration tab’s Action 
Items view pane. The action item is now listed as 
pending on the creator.

Reopen the action 
item and inform 
<assignee> that it 
needs more work

Enables the creator to change the status of an action item 
from Done to Reopen or Closed.

Respond with a post Enables any HP Release Control user to add a comment 
to any action item that is not closed.

When the action item is selected in either the Action 
Items List pane or the Collaboration tab’s Action Items 
view, the comment appears in the Action Item Posting 
pane. 

GUI Element (A-Z) Description
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Review > Conclusions Tab

Description Enables the Change Reviewer to:

➤ Add review notes to any change request with an 
Evaluation and Closure status. 

➤ Close the request so that no further modifications can 
be made to it.

The review notes present the conclusions regarding the 
request, providing information about its overall success 
and satisfaction levels of relevant parties.

If you are working with HP Service Manager, you can 
synchronize PIR information directly to that application, 
and synchronize information from HP Service Manager 
to HP Release Control.

To access: In the Analysis and Details pane, click the 
Review > Conclusions tab.

Important 
Information

➤ The Change Reviewer can use the Send by E-mail  
button on the Change Requests toolbar to send an 
email invitation to participate in a PIR meeting, as 
well as a summary of the PIR conclusions for any 
completed request.

➤ You can define a change request filter according to 
review-related criteria. For details, see "Filtering 
Change Requests, Activities, and Action Items" on 
page 147.

Useful Links "Post Implementation Review Dialog Box" on page 129
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Conclusion Information Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create/edit a PIR for any change request 
with an Evaluation and Closure status. 

If you are working with HP Service Manager, you can also 
close the request so that no more modifications can be 
made to it.

Important 
Information

The Close button in this pane is available only if you are 
working with HP Service Manager. If you are using any 
other service desk application, the Close button is 
disabled.

GUI Element (A-Z) Description

If you are fully integrated with HP Service Manager, 
enables you to create/edit a PIR for any change request 
whose status is not Closed. Opens the Post 
Implementation Review dialog box.

Note: If you are using any other service desk application, 
the button is disabled.

If you are fully integrated with HP Service Manager, 
enables you to close the request directly to HP Service 
Manager so that no more modifications can be made to 
it.

Note: If you are using any other service desk application, 
the button is disabled.

Opens the Login dialog box. Enter your HP Service 
Manager user name and password. If the operation is 
successful, the ticket is updated in HP Service Manager, 
which then updates the request in HP Release Control to 
a Closed status.

<Conclusion 
information>

Contains the review information entered in the Post 
Implementation Review dialog box for the selected 
request.
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Disrupted Business CIs Pane

Review > Event Log Tab

Description Displays the disrupted business CIs selected in the Post 
Implementation Review dialog box to be included in the 
PIR.

Description Displays events related to activities. These can be user- or 
system-induced events. For information on what the 
Event Log displays, see "Event Log Tab" on page 184.

➤ To access in Analysis module: In the Details and 
Analysis pane, click the Review > Event Log tab.

➤ To access in Director module: In either the Activity 
Timeline or Alerts pane, click Activity Information  
to open the Activity Information dialog box. Then 
click the Event Log tab.
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Review > Verifications Tab

Description Enables you to view data for detected and latent 
changes.

The selected request’s detected changes are displayed 
along with information received from the HP Universal 
CMDB.

For more information on detected and latent changes, 
see "Detected and Latent Changes" on page 46.

The Detected Changes pane displays the following 
information for each detected change:

➤ CI Name. The name of the CI that was changed.

➤ CI Type. The type of CI that was changed.

➤ Change Type. The type of change performed on the 
CI.

➤ Detection Window. The change detection time range 
when the detected change was discovered.

The Changed Attributes pane displays the following 
information for each detected change:

➤ Attribute. The specific aspect of the CI that was 
changed. For example, the operating system 
(OS_VERSION).

➤ Old Value. The attribute’s definition before the 
change. For example, XP SP1. 

➤ New Value. The attribute’s definition after the change. 
For example, XP SP2.

Latent changes are displayed as separate changes in the 
Change Requests List View, along with all the other 
change requests. A latent change is indicated by the 
Latent  icon and the words Latent change in the List 
view’s Summary column.

To access: In the Analysis and Details pane, click 
Review > Verifications tab.
145



Chapter 4 • Analysis Module
Important 
Information

➤ This feature may not be available in your HP Release 
Control application. For more information, contact 
your HP Release Control administrator.

➤ This section assumes that the latent change feature is 
fully activated.
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5
Filtering Change Requests, Activities, and 
Action Items

This chapter includes:

Concepts

➤ Change Request, Activity, and Action Item Filter Overview on page 147

➤ Regular Expressions on page 150

Tasks

➤ Create a Union Filter - Use-Case Scenario on page 151

Reference

➤ Filtering User Interface on page 152
Concepts

Change Request, Activity, and Action Item Filter 
Overview

You can filter change requests and action items in the Analysis module and 
you can filter activities in the Director module. You can select either a public 
filter or a filter that you previously defined, or you can define a new filter.

Regardless of where you create the filter, the same filters are visible in both 
the Analysis module and the Director module.

For details on the Analysis module, see "Analysis Module" on page 33. For 
details on the Director module, see "Director Module" on page 175.
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This section also includes:

➤ "Using Filters in the Analysis Module" on page 148

➤ "Using Filters in the Director Module" on page 150

Using Filters in the Analysis Module
You use the filter mechanism in the Filters pane to define a set of criteria by 
which HP Release Control determines which change requests to display in 
the Change Requests mode or which action items to display in the Action 
Items mode. For details, see "Change Requests/Action Items Pane" on 
page 116.

If you are working in the Change Requests mode, you can:

➤ Search for a specific change request by entering the request’s ID number 
in the search box at the top right corner of the page and clicking the Find  
button. For a list of regular expressions that can be used, see "Regular 
Expressions" on page 150.

➤ Select a change request filter. HP Release Control displays the change 
requests that meet the criteria of the change request filter you selected.

➤ Select an action item filter. HP Release Control displays the change 
requests that are associated with the action items that meet the criteria of 
the action item filter you selected.

➤ Select both a change request filter and an action item filter. HP Release 
Control displays the change requests that meet the criteria of the change 
request filter you selected and are associated with the action items that 
meet the criteria of the action item filter you selected. For example, if you 
want to view all high risk change requests that have open action items 
associated with them, you select both a change request filter that includes 
only high risk change requests and an action item filter that includes only 
open action items.
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If you are working in the Action Items mode, you can:

➤ Search for a specific action item by entering the action item’s ID number 
in the search box at the top right corner of the page and clicking the Find  
button. For a list of regular expressions that can be used, see "Regular 
Expressions" on page 150.

➤ Select an action item filter. HP Release Control displays the action items 
that meet the criteria of the action item filter you selected.

➤ Select a change request filter. HP Release Control displays the action items 
that are associated with the change requests that meet the criteria of the 
change request filter you selected.

➤ Select both an action item filter and a change request filter. HP Release 
Control displays the action items that meet the criteria of the action item 
filter you selected and are associated with the change requests that meet 
the criteria of the change request filter you selected. For example, if you 
want to view all action items assigned to you that are associated with high 
priority change requests, you select both an action item filter that 
includes only action items assigned to you and a change request filter that 
includes only high priority change requests.

Note:

➤ You can use the Back and Forward buttons to navigate between your 
various mode and filter selections.

➤ The action item filter is not applied to the Action Items view in the 
Collaborate tab. If you are working with the Change Requests mode, this 
view displays all the action items associated with the selected change 
request. If you working with the Action Items mode, this view displays all 
the action items associated with the change request with which the 
selected action item is associated.
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Using Filters in the Director Module
You use the filter mechanism at the top of the Director module to define a 
set of criteria by which HP Release Control determines which activities to 
display in the Director module. 

The filter mechanism in the Director module works in the same way as the 
filter mechanism in the Analysis module and you can use filters created in 
the Analysis module to filter activities in the Director module. However, 
some of the filter criteria that are only relevant to the Analysis module are 
not included in the Director module and vice versa.

For example, time-related criteria, which are only relevant to the Analysis 
module are not included in Director module. If a filter was created in the 
Analysis module with time-related criteria, the filter can still be used in the 
Director module. However, you are not able to edit time-related criteria in 
the Director module.

Regular Expressions

In certain filter and search fields , you can use regular expressions to refine 
your search or filter. In these fields, you can use the following regular 
expressions:

➤ OR or a comma (,). This creates a logical OR between the predicates. For 
example, if you enter david OR steve, both david and steve are included 
in the filter. Similarly, if you enter steve, da*, both steve and any string 
that begins with da are included in the filter.

➤ NOT. By entering NOT at the beginning of the expression, a logical NOT is 
created for the whole expression. The NOT refers to the entire logical 
condition, regardless of whether it contains one predicate or more. 
Parentheses should not be specified. For example, if you enter NOT a*, all 
strings that do not begin with the letter a are included in the filter. 
Similarly, if you enter NOT da*, steve, all strings that do not begin with 
the letters da and are not steve is included in the filter.

An asterisk (*) indicates any number of zero or more characters. A question 
mark (?) indicates any single character.

Tasks
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Create a Union Filter - Use-Case Scenario

In your next Change Advisory Board meeting, you are going to discuss 
change requests that are scheduled to be implemented during the first week 
in June 2009 that are high risk, collide critically with other requests, or have 
been voted on prior to the CAB.

This task describes how to create a union filter that displays the change 
requests whose criteria meet these conditions.

This task includes the following steps:

➤ "Define a New Filter" on page 151

➤ "Combine the Next CAB Meeting Filter with Existing Filters" on page 151

➤ "Results" on page 151

 1 Define a New Filter

Select Module > Analysis. In the Change Requests/Action Items pane, 
click the downward arrow  to the right of the Change Requests box 
and select New. Define a new filter called Next CAB Meeting. In the Time 
tab, select the first week in June under Planned within. For more 
information on how to define a filter, see "Activity Filter/Change Request 
Filter/Action Item Filter Dialog Box" on page 152.

 2 Combine the Next CAB Meeting Filter with Existing Filters

In the Union Filters tab. Select the Critical collisions, High risk, and Voted 
to CAB filters that were previously defined in HP Release Control. For 
more information on the Union Filters tab, see "Activity Filter/Change 
Request Filter/Action Item Filter Dialog Box" on page 152.

 3 Results

When you select the Next CAB Meeting filter, HP Release Control displays 
all the change requests that are scheduled for the first week in June 2009 
and meet any one of the following criteria:

➤ Risk = high 

➤ Collision severity = critical
151



Chapter 5 • Filtering Change Requests, Activities, and Action Items
➤ Contain votes to CAB
Reference

Filtering User Interface

This section describes (in alphabetical order):

 ➤ Activity Filter/Change Request Filter/Action Item Filter Dialog Box 
on page 152

 ➤ Filters Selection List on page 168

 ➤ Save Filter Dialog Box on page 170

Activity Filter/Change Request Filter/Action Item Filter 
Dialog Box

Description Creates a new change request or activity filter. In the 
Analysis module, you can create a new change request 
filter in either the Change Requests or Action Items 
mode. You can also create a new filter in the Director 
module.

You filter activities according to different criteria. These 
criteria are divided into predefined filter categories. You 
can also combine the results of the current filter with 
other existing filters in the Union Filters tab. 

➤ To access in the Director module: Select Module > 
Director. In the Activities Timeline pane, click the 
downward arrow  to the right of the Activities box 
and select New or Edit.

➤ To access in the Analysis module: Select Module > 
Analysis. In the Change Requests/Action Items pane, 
click the downward arrow  to the right of the 
Change Requests or Action Items box and select New 
or Edit.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

➤ HP Release Control applies all defined criteria to a 
filter (using the AND operator). For example, if you 
defined a filter with Priority set to High and Impact 
Severity set to Critical, you only see results that meet 
both these criteria (Priority: High and Impact Severity: 
Critical).

➤ The HP Release Control administrator can remove 
some of the pre-defined filter criteria. Some of the 
criteria listed in the description of the General, 
Analysis Data, Business CIs, and Union Filters tabs, 
therefore, may not be available.

➤ The HP Release Control administrator can create 
additional customized filters, in which case additional 
filter categories are available in the Activity Filter 
dialog box. For details on creating customized filters, 
refer to the HP Release Control Configuration Guide.

➤ Some filter criteria may be included in one module 
and not in another. If a filter was created in one 
module with criteria that are only relevant to that 
module, the filter can still be used in the other module 
but with some limitations.

For example, time-related criteria, which are only 
relevant to the Analysis module are not included in 
Director module. If a filter was created in the Analysis 
module with time-related criteria, the filter can still be 
used in the Director module. However, you cannot 
edit time-related criteria in the Director module.

Included in Tasks "Create a Union Filter - Use-Case Scenario" on page 151

GUI Element (A-Z) Description

Clear. Clear all the selected filter properties.
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General Tab

The following elements are included when you create a filter for change 
requests and activities (unlabeled GUI elements are shown in angle 
brackets):

Save As. Save your filter settings. Opens the Save Filter 
dialog box.

View Filtered Results. View the filter results in the 
Activity Timeline pane without saving the filter.

Description Contains filter criteria which are based on fields that 
originate in the service desk application.

To access: Click the General tab in the Activity Filter/
Change Request Filter/Action Item Filter dialog box.

GUI Element (A-Z) Description

Category Filters change requests according to category.

Change type Filters activities according to their request type. The 
following options are available:

➤ Planned. Displays regular change requests scheduled 
in HP Release Control.

➤ Latent. (Available if the latent change feature is 
configured). Displays change requests detected by 
HP Universal CMDB. For more information, see 
"Detected and Latent Changes" on page 46.

➤ Surrogate. Displays change requests automatically 
created by HP Release Control to represent a change 
request existing in the service desk application that 
has not yet been retrieved by HP Release Control.

➤ Automated. Displays changes that originate from HP 
Network Automation or HP Server Automation.

GUI Element (A-Z) Description
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Contact person Filters change requests according to the contact people 
responsible for the change requests. For a list of the 
regular expressions that can be used, see "Regular 
Expressions" on page 150.

Detection status Filters change requests according to the way in which 
they were detected. The following options are available:

➤ Not detected. Displays regular change requests 
scheduled in HP Release Control.

➤ Detected. Displays latent changes, or change requests 
that contain detected changes. For more information, 
see "Detected and Latent Changes" on page 46.

Note: Relevant to Analysis module only. Available only if 
the Latent change feature is configured.

Emergency Filters change requests as follows:

➤ True. Change requests that were handled in an 
emergency procedure.

➤ False. Change requests that were not handled in an 
emergency procedure.

GUI Element (A-Z) Description
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Hierarchy level Filters activities according to their hierarchical structure. 
The following options are available:

➤ Change. Displays only top-level change requests.

➤ Task. Displays only second-level change requests.

➤ Changes and Independent Tasks. Displays all changes 
and those tasks that are not part of a parent change.

If you do not filter activities by this criterion, all 
changes and tasks, including tasks that are part of a 
parent change, are displayed on one level and not in a 
hierarchical structure.

Note: The names of the top-level and second-level 
change requests can be configured in the 
enumeration-labels.properties file. For more 
information, see "Configuring Enumeration Field Display 
Settings" in the HP Release Control Configuration Guide.

In addition, if you modify the names of the top-level and 
second-level requests, you should modify the 
filters.constraints.hierarchy.@@CHANGES_AND_ORPHA
NS_TASKS@@ resource in the <HP Release Control 
installation directory>\tomcat\webapps\ccm\WEB-INF\
classes\onyxCommonResources.properties file 
accordingly, so that the last option in this selection box 
does not read Changes and Independent Tasks.

Implementors Filters change requests according to their implementors. 
To select an implementor, you can either type the name 
of the implementor in the box or you can click the Select 
From List  button and select an implementor from 
the dialog box that opens. For a list of the regular 
expressions that can be used, see "Regular Expressions" 
on page 150.

Service desk Filters change requests according to the service desk 
applications from which they originated. You can select 
one or more of the listed service desk applications.

GUI Element (A-Z) Description
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The following elements are included when you create a filter for action 
items (unlabeled GUI elements are shown in angle brackets):

Status Filters change requests according to their statuses. You 
can select one or more of the listed statuses. The status is 
determined in the service desk application.

Subcategory Filters change requests according to subcategory.

GUI Element (A-Z) Description

Assignee Filters action items according to the user to whom they 
were assigned. You can either enter the name of the 
assignee in the text box provided or click the  button 
to the right of the text box to locate and select the 
assignee in the Select Users dialog box.

Creator Filters action items according to the user who created 
them. You can either enter the name of the creator in the 
text box provided or click the  button to the right of 
the text box in order to locate and select the creator in 
the Select Users dialog box.

Pending on Filters action items according to the user whose action is 
being awaited. You can either enter the name of a user in 
the text box provided or click the  button to the right 
of the text box in order to locate and select a user in the 
Select User dialog box.

Priority Filters change requests according to their priority levels. 
You can select one or more of the listed priority levels. 
The priority levels are determined in the service desk 
application.

Status Filters change requests according to their statuses. You 
can select one or more of the listed statuses. The status is 
determined in the service desk application.

GUI Element (A-Z) Description
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Analysis Data Tab

Description Describes the filter criteria, which are based on the 
calculations that HP Release Control performs during the 
processing of change requests.

To access: Click the Analysis Data tab in the Activity 
Filter/Change Request Filter/Action Item Filter dialog 
box.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Calculated risk Filters change requests according to their risk analysis 
levels. The risk analysis level is a number from 0-100 that 
indicates the risk level of this change request relative to 
the other change requests. A higher number indicates a 
higher risk level.

Enter or select a range using the boxes provided. 

For more information about the calculation of risk levels, 
see "Risk Analysis" on page 36.

CIs Filters change requests according to the CIs affected by 
each change request based on the impact analysis 
calculation. To select CIs, you can either type the names 
of the CIs in the box or you can click the Select Values 

 button to open the Select Values dialog box.

For a list of the regular expressions that can be used, see 
"Regular Expressions" on page 150.

To select CIs using the Select Values dialog box, select the 
relevant CIs in the Available Values list, double-click 
them or click the top arrow to move them to the Selected 
Values list and click OK. To deselect a CI, select the CI in 
the Selected Values list and click the bottom arrow.

Note: If you use the NOT regular expression, the filter 
excludes all change requests that contain only the 
specified CI and no other CIs. However, if a change 
request also includes other CIs besides the one you 
specified, that change request is still displayed in the 
results.

Collision severity Filters change requests according to their collision 
severity levels. You can select one or more of the listed 
collision severity levels. 

Collision severity is calculated by HP Release Control. For 
more information about collision severity, see "Change 
Request Collisions" on page 41.
159



Chapter 5 • Filtering Change Requests, Activities, and Action Items
Collision type Filters change requests according to the types or causes of 
the collisions. You can select one or more of the listed 
collision causes. For more information about collision 
causes, see "Change Request Collisions" on page 41.

Note: If you defined a custom collision cause, you can 
select the name of the field you specified as a collision 
cause.

Note: Relevant to the Analysis module only.

Discussion created Filters change requests according to the time at which 
request discussion threads and comments were added.

Note: Relevant for the Analysis module only.

Impact severity Filters change requests according to their impact severity 
levels. You can select one or more of the listed impact 
severity levels. 

Impact severity is calculated by HP Release Control. For 
more information about impact severity, see "Impact 
Analysis" on page 35.

Note: You cannot filter by impact severity level if you 
selected Requests with unknown impact in the Business 
tab.

GUI Element (A-Z) Description
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Business CIs Tab

Time period conflicts Filters change requests according to the time period 
categories whose recurrence rules the requests breach. 
You can select one or more of the listed time period 
categories. For more information on time period 
categories, see "Configuring Time Periods" in the 
HP Release Control Configuration Guide.

Note: Relevant to the Analysis module only. When you 
view the filtered change requests in the Timeline and 
Calendar views, the time period categories you selected 
in the Change Requests Filter are automatically 
displayed.

Voted as Filters change requests according to the user votes they 
received. You can select one or more of the listed voting 
options.

Users can express their opinion about a change request 
by posting a vote (Disagree, To CAB, Agree, No vote) 
regarding the request. For more information on change 
request voting, see "Collaborate > Discussion Tab" on 
page 119.

Note: Relevant for the Analysis module only.

Description Filters change requests according to impact.

To access: Click the Business CIs tab in the Activity Filter/
Change Request Filter/Action Item Filter dialog box.

Useful Links "Regular Expressions" on page 150

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Show Obsolete. Toggle between hiding and displaying 
the obsolete CIs.

Note: Available only when you select the Requests 
affecting selected business CIs option. 

Find. Search for a specific business CI by entering the 
name or part of a name in the search box. The search 
returns all business CIs that contain the entered string 
somewhere in the name.

Click the Find button to run the search.

Move the selected business CIs from the Available 
Business CIs list to the Selected Business CIs list. The 
business CI is included in the filter.

Move the selected business CIs from the Selected 
Business CIs list to the Available Business CIs list. The 
business CI is not included in the filter.

<View other pages> To view other pages, use the left and right arrows. The 
number between the left and right arrows indicate which 
page is currently being displayed. For example, 3 of 5 
means that the 3rd page out of 5 is being displayed.

All requests Displays all change requests.

Available Business CIs The list of available business CIs.

Notes: 

➤ Available only when you select the Requests affecting 
selected business CIs option.

➤ You can select multiple business CIs using the CTRL 
key.

Requests affecting 
any business CI

Displays change requests whose impact analysis results 
affect any business CI.
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Time Tab

Requests affecting 
my business CIs

Displays change requests whose impact analysis results 
affect the business CIs associated with you.

Requests affecting 
selected business CIs

Displays only change requests for which there are no 
impact analysis results

Requests with 
unknown impact

Displays only change requests for which there are no 
impact analysis results

Selected Business CIs Displays the business CIs you want to include in the 
filter.

Notes: 

➤ Available only when you select the Requests affecting 
selected business CIs option.

➤ You can select multiple business CIs using the CTRL 
key.

Description Filters change requests according to time-related criteria 
by selecting one or more of the time-related options.

From the box adjacent to each filter criterion that you 
selected, select the desired option from the drop-down 
list.

If you selected After, Before, or Between, click the 
calendar  button and select a date and time.

Note: You select time intervals according to your 
machine’s time zone, as indicated in the calendar box.

To access: Click the Time tab in the Activity Filter/
Change Request Filter/Action Item Filter dialog box.

Important 
Information

This tab is only available in the Analysis mode.

GUI Element (A-Z) Description
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The following elements are included when you create a filter for change 
requests and activities (unlabeled GUI elements are shown in angle 
brackets):

GUI Element (A-Z) Description

Actual end Filters change requests according to their actual 
execution end time. 

Actual start Filters change requests according to their actual 
execution start time. 

Created Filters change requests according to the time at which 
they were created.

Implemented within Filters change requests according to the time range in 
which they were implemented. Any part of the actual 
implementation that falls within this time range is 
included in the filter.

Last update Filters change requests according to the time at which 
they were last updated.

Planned end Filters change requests according to their planned 
execution end time. 

Planned start Filters change requests according to their planned 
execution start time. 

Planned within Filters change requests according to the time range in 
which they were scheduled to take place. Any part of the 
planned execution that falls within this time range is 
included in the filter.

Requested end date Filters change requests according to the date by which 
the implementation of the change request must be 
completed.

Scheduled downtime 
end

Filters change requests according to when their 
downtime is scheduled to end.

Scheduled downtime 
start

Filters change requests according to when their 
downtime is scheduled to start.
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The following elements are included when you create a filter for action 
items (unlabeled GUI elements are shown in angle brackets):

Review Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Due date Filters actions items according to the date by which they 
must be completed.

Modified Filters actions items according to the time at which they 
were modified.

Description Filters requests according to review-related criteria.

To access: Click the Review tab in the Activity Filter/
Change Request Filter/Action Item Filter dialog box.

Important 
Information

This tab is only available in Analysis mode.

GUI Element (A-Z) Description

Customer 
satisfaction

Filters change requests according to the customer 
satisfaction rating they were assigned by change 
reviewers. You can select one or more of the listed 
ratings.

Disrupted Business 
CIs

Filters change requests according to the business CIs that 
were negatively affected by their implementation. You 
can select one or more business CIs (using the CTRL key) 
from the Available Business CIs list and click the top 
arrow to move the selected business CIs to the Selected 
Business CIs list.

Outcome Filters change requests according to the outcomes they 
have been assigned by change reviewers. You can select 
one or more of the listed outcomes.
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Planning satisfaction Filters change requests according to the planning 
satisfaction rating they were assigned by change 
reviewers. You can select one or more of the listed 
ratings.

Reviewed Filters change requests according to the time at which 
they were reviewed. 

You define the review time interval by choosing the 
desired option from the selection box drop-down list. If 
you select After, Before, or Between, click the calendar 
button to open the calendar box, select a month using 
the left and right arrows next to the month name, select 
a date from the calendar, enter or select an exact hour in 
the time box, and click OK.

Note: You select the time interval according to your 
machine’s time zone, as indicated in the calendar box.

GUI Element (A-Z) Description
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Union Filters Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select an existing filter whose criteria you 
want to combine with the filter you are currently 
defining. 

Note: You can select multiple filters using the CTRL key.

To access: Click the Union Filters tab in the Activity 
Filter/Change Request Filter/Action Item Filter dialog 
box.

Important 
Information

A union filter uses the A AND (B OR C OR D OR...) 
operator, where A is the current filter and B, C, and D... 
are existing HP Release Control filters. For an example, 
see "Create a Union Filter - Use-Case Scenario" on 
page 151.

Notes:

➤ The Favorites filter and filters containing union filters 
do not appear in the Available Filters list and therefore 
cannot be combined as union filters with the current 
filter you are defining.

➤ If you chose to combine private filters with the filter 
you are currently defining, you can save the current 
filter only as a private filter.

➤ You cannot combine filters that were defined by an 
administrator as time period filters with filters that 
were not defined as time period filters.

GUI Element (A-Z) Description

Move the selected filters from the Available Filters list to 
the Selected Filters list. The selected filters are combined 
with the filter you are currently defining.

Move the selected filters from the Selected Filters list to 
the Available Filters list. The selected filters are not 
combined with the filter you are currently defining.
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Filters Selection List

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Available Filters The existing filters.

Selected Filters Select the filter whose results you want to combine with 
the current filter. 

Description Enables you to define a set of criteria by which to 
determine the activities to be displayed in the Activity 
Timeline pane in the Director module and in the Filters 
pane in the Analysis module.

➤ To access in the Director module: Select Module > 
Director and then, in the Activities Timeline pane, 
click the downward arrow  to the right of the 
Activities box.

➤ To access in the Analysis module: Select Module > 
Analysis. and then, in the Change Requests/Action 
Items pane, click the downward arrow  to the right 
of the Change Requests or Action Items box.

GUI Element (A-Z) Description

New. Define a new filter. Opens the Activity Filter/
Change Request Filter/Action Item Filter dialog box. 

Edit. Edit an existing filter. Opens the Activity Filter/
Change Request Filter/Action Item Filter dialog box.

GUI Element (A-Z) Description
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Organize. Delete an existing filter. Opens the Available 
Filters dialog box.

Note: You can delete any filter that you created, unless it 
is a time period filter that has been used in defining a 
time period category, or a filter that is being used as a 
union filter within another filter. If you are an 
administrator, you can delete any public filter except the 
Any filter. The automatically generated Favorites filter 
cannot be deleted. 

Save as. Copy any filter except the Favorites filter by 
saving it under a different name or with different access 
(private/public) properties. Opens the Save Filter dialog 
box.

For example, if you are a user without administrative 
privileges and want to modify one of the public filters, 
you can rename the public filter so that it is saved as one 
of your personal filters and then modify the filter’s 
properties.

Notes: 

➤ You cannot modify the properties of the automatically 
generated Favorites filter.

➤ Only an administrator can modify the properties of 
the public filters.

➤ If the modified filter is a time period filter and is 
included in time period categories, HP Release Control 
recalculates the compliance of the change requests 
that fit the configured categories with the rules 
pertaining to these categories.

Denotes a filter.

Denotes a union filter. For details, see "Union Filters Tab" 
on page 167.

My Filters folder Displays the filters that are saved to the My Filters folder. 
These filters are not viewed by any other user. For details, 
see the Save Filter dialog box.

GUI Element (A-Z) Description
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Save Filter Dialog Box

Public Filters folder Displays the filters that are saved to the Public Filters 
folder by selecting the Public Filters option in the Save 
Filter dialog box. 

Notes: 

➤ Filters that appear under the Public Filters folder can 
be viewed by all users.

➤ If you have not been assigned the administrator role, 
the filter appears under the My Filters folder.

Time Period Filters Displays the filters that are saved to the TIme Period 
Filters folder by selecting the Time Period Filter option in 
the Save Filter dialog box.

Description Save your filter settings and display the filter results in 
the Action Items pane.

Note: If the saved filter is a time period filter and is 
included in time period categories, HP Release Control 
recalculates the compliance of the change requests that 
fit the configured categories with the rules pertaining to 
these categories.

To access:

➤ In the Activity Filter/Change Request Filter/Action 
Item Filter dialog box, click  Save.

or

➤ In the Filters Selection list, click Save as.

Important 
Information

Once you have saved the filter, it appears in one of the 
following categories in the Filters Selection list:

➤ My Filters

➤ Public Filters (if the Public filter check box was 
selected)

➤ Time Period Filters (if the Time Period Filter check box 
was selected)

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Description Enter a description for the filter.

Name Enter the name of the filter.

Note: You cannot use a a question mark (?) or the 
ampersand character (&) in the filter name.

Public Filter If you are assigned the Administrator or Change Manager 
role, you can select the Public Filter check box to enable 
the filter you are creating to be viewed by all users

Note: If you are a regular user, the filter appears under My 
Filters in the filter selection list. If you are an 
administrator and selected the Public filter check box, the 
filter appears under Public Filters in the filter selection 
list.

Time Period Filter If you are an administrator and want to be able to define 
a time period category based on the filter you are 
creating, select the Time Period Filter check box. The 
filter then appears in the Select Filter dialog box and you 
can select this filter when defining a time period category 
in the Administration module’s Time Periods tab. For 
details on defining time periods, see "Configuring Time 
Period Settings" in the HP Release Control Configuration 
Guide.

Note: The Time period filter check box cannot be selected 
in the following cases:

➤ If the Time Period Conflicts option is selected in the 
Analysis Data tab

➤ If the Requests affecting my business CI option is 
selected in the business CIs tab

➤ If options other than Before, After, or Between are 
selected in the Time tab
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6
Director Module

Note: This chapter is intended for NOC Users. That is, most of the actions 
described require NOC privileges.

This chapter includes:

Concepts

➤ Director Module Overview on page 176

➤ Viewing Activities on the Timeline on page 176

➤ Activity Alerts on page 178

➤ User Communication on page 179

Tasks

➤ Monitor the Implementation Progress of an Activity on page 179

Reference

➤ Director Module User Interface on page 180
Concepts
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Director Module Overview

The Director module enables you to monitor the status of change requests 
scheduled for implementation. 

All users can view the Director module. If you are a NOC user (users who are 
assigned the NOC role), you can perform actions in this module. If you do 
not have NOC privileges, for example, a Release Manager or Change 
Manager, you can use this module to communicate with other users about 
change requests that interest you.

During the implementation stage, change requests are referred to as 
activities. In the Director module, you can observe events surrounding the 
activities, such as updates to the status of activities, problems that occur 
during implementation, and so on. If problems arise, you can take 
immediate action, ensuring that implementation runs as efficiently and 
with as little impact on the production environment as possible. 

For an example of how to monitor the implementation progress of an 
activity and how to handle the problems that may arise during the 
implementation, see "Monitor the Implementation Progress of an Activity" 
on page 179.

Viewing Activities on the Timeline

The Activity Timeline pane lists activities scheduled within a selected time 
range and their schedules are displayed graphically on a timeline. For 
details, see "Activity Timeline Pane" on page 187.

The graphical representation of an activity schedule indicates the status of 
the activity. If an activity’s schedule is modified, this is indicated on the 
timeline. For details, see "Representation of Activities on the Timeline" on 
page 177 below.
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The timeline area is divided into a shaded area representing time in the past, 
and a non-shaded area representing time in the future. The vertical line 
dividing the past and future represents the current time. By default, the 
table displays activities scheduled up to 12 hours behind the current time 
and 12 hours ahead of the current time. You can change the time interval 
displayed on the timeline. For details, see "Modifying the Time Display of 
the Timeline" on page 178 below.

You can filter the activities to view only those with certain criteria. For 
details, see "Filtering Change Requests, Activities, and Action Items" on 
page 147.

This section also includes:

➤ "Representation of Activities on the Timeline" on page 177

➤ "Modifying the Time Display of the Timeline" on page 178

Representation of Activities on the Timeline
The timeline displays activities in such a way that the you can immediately 
identify an activity’s planned schedule and the current status of the activity.

The planned schedule of an activity is represented by an empty horizontal 
bar, while the actual implementation period is represented by a solid bar. 

For example, in the following image the planned schedule for 
Activity C00000221 is represented by an empty bar. The solid bar represents 
the actual implementation time. You can see that the implementation of the 
activity started at about 01:30 PM.

Downtime for an activity is indicated on the timeline by a solid, dark gray 
bar. In the above example, downtime was started at about 02:15 PM.
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The color of an activity on the timeline is determined by whether or not 
there are alerts for the activity, or if it has finished implementation.

➤ If there are no alerts for the activity, the activity is displayed in green.

➤ If there are alerts for the activity, the activity is displayed in red, yellow, or 
blue, according to the alert for the activity with the highest severity. For 
more information about activity alerts, see "Activity Alerts" on page 178.

➤ If the implementation of an activity is complete, the activity is displayed 
in gray.

Modifying the Time Display of the Timeline
The timeline is divided into four equal parts where, by default, half of the 
time displayed is in the past, represented by a shaded area, and half of the 
time is in the future, represented by the non-shaded area. The current time 
is represented by the vertical line separating the past and the future.

You can modify the time range displayed on the timeline, and the time 
amount of past/future time displayed. For details, see "Activity Timeline 
Pane" on page 187.

Activity Alerts

The Alerts pane of the Director module displays alerts about activities 
displayed on the timeline. These alerts notify you about problems detected 
regarding the listed activities, prompting you to take action where 
necessary. For details, see "Alerts Pane" on page 190.

Alerts can indicate errors or warnings, or can simply be informative. They 
are generated under any of the following circumstances:

➤ An activity started earlier than scheduled 

➤ An activity is likely to start late or started late 

➤ An activity is likely to end late or ended late 

➤ An activity breached a Time Period without approval from the Change 
Advisory Board (CAB) 

➤ An activity has pre- or post-implementation guidelines 
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➤ An activity is likely to collide or collides with another activity without 
approval from the CAB 

➤ An implementor is calling for assistance 

➤ An emergency activity was added 

➤ An activity’s details were modified 

User Communication

You can communicate with other users to convey or obtain information 
regarding the common activities with which you are associated, or regarding 
other topics through the Communications pane. For details, see 
"Communications Pane" on page 215.

Tasks

Monitor the Implementation Progress of an Activity

This task describes how to monitor the implementation progress of an 
activity and how to handle the problems that may arise during the 
implementation.

This task includes the following steps:

➤ "Check the Activity for Alerts" on page 179

➤ "Understand Why an Activity is Delayed" on page 180

➤ "Reschedule an Activity to Avoid Collisions" on page 180

 1 Check the Activity for Alerts

John Smith is the NOC Change Manager for ABC Software Company. He 
is responsible for monitoring the implementation progress for the 
deployment of a new webmail server.
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In the Activity Timeline pane, John selects the activity on which he is 
working. In the Alerts pane, there is an alert notifying him that the 
activity has started late. As a result, the activity is scheduled to collide 
with another activity without the approval of the CAB. For details on the 
Alerts pane, see "Alerts Pane" on page 190.

 2 Understand Why an Activity is Delayed

John wants to understand why the activity is not starting on time. So he 
communicates with the implementor in charge of the activity by opening 
a chat room in the Communications pane to obtain information 
regarding the reasons for the delay. For details about the 
Communications pane, see see "User Communication" on page 213.

 3 Reschedule an Activity to Avoid Collisions

To avoid a collision with another activity, John decides to reschedule an 
activity to end earlier than the original CAB planned schedule. He clicks 
Reschedule Activity in the Activity Timeline pane to open the Reschedule 
Activity dialog box. For details, see "Reschedule Activity Dialog Box" on 
page 196.

Reference

Director Module User Interface

This section describes (in alphabetical order):

 ➤ Activity Information Dialog Box on page 181

 ➤ Activity Timeline Pane on page 187

 ➤ Alerts Pane on page 190

 ➤ CI Attributes Dialog Box on page 193

 ➤ Communications Pane on page 194

 ➤ Director Module Window on page 194

 ➤ Handle Alerts Dialog Box on page 195

 ➤ Notes for Activity <ID> Dialog Box on page 196
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 ➤ Reschedule Activity Dialog Box on page 196

 ➤ Update Activity Status Dialog Box on page 197

Activity Information Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Details Tab

Description Enables you to view information about each activity. The 
information provided comprises all the details about the 
activity. It also displays pre- or post-implementation 
guidelines, and any events related to the activity, for 
example, if the activity was rescheduled, if the status was 
updated, and so on.

➤ To access in Director Module: Select the required 
activity in either the Activity Timeline pane or the 
Alerts pane, and click  Activity Information.

➤ To access in Implementor Module: Select Module >  
Implementor. Select the required activity in the To-Do 
List pane, and click  Activity Information.

Included in Tasks "Monitor the Implementation Progress of an Activity" on 
page 179

Useful Links ➤ "Review Tab" on page 165 

➤ "Alerts Pane" on page 190

GUI Element (A-Z) Description

View in Analysis View the activity in the Analysis module.

Description Displays details about the selected activity.

To access: Click the Details tab in the Activity 
Information dialog box.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Actual End The date and time at which implementation of the 
activity actually ended.

Actual Start The date and time at which implementation of the 
activity actually started.

Change Type The type of change (for example, planned or automated).

Contact Location The geographic location of the person responsible for the 
activity.

Contact Person The name of the user responsible for the activity.

Created The date and time at which the activity was originally 
created in the service desk application.

Description A description of the activity.

Estimated Risk The estimated risk level that was assigned to the activity 
by a user.

Impact Severity The impact severity level of the activity, as calculated by 
HP Release Control.

Implementors The people responsible for implementing the activity.

Last Impact The time at which an impact analysis was last calculated.

Last Update The last time the activity was updated in the service desk 
application.

NOC Planned End The date and time that the activity implementation is 
scheduled to end, as rescheduled by the NOC users.

NOC Planned Start The date and time that the activity implementation is 
scheduled to start, as rescheduled by the NOC users.

Planned End The date and time that the activity implementation is 
scheduled to end.

Planned Start The date and time that the activity implementation is 
scheduled to start.
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Implementation Guidelines Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Priority The priority level of the activity.

Request ID The reference ID number of the activity in the service 
desk application.

Risk A number from 0 – 100 that indicates the risk level of this 
activity relative to the other activities, as calculated by 
HP Release Control.

Service Desk The service desk application in which the activity 
originated.

Description Displays CAB-assigned guidelines to follow before and/or 
after implementing the activity.

To access: Click the Implementation Guidelines tab in 
the Activity Information dialog box.

GUI Element (A-Z) Description

Post-Implementation Displays CAB-assigned guidelines to follow after 
implementing the activity.

Pre-Implementation Displays CAB-assigned guidelines to follow before 
implementing the activity.

GUI Element (A-Z) Description
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Event Log Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays all events related to the selected activity.

These events can be either user- or system-induced. 

➤ User-induced events include:

➤ Updates to the status of an activity

➤ Changes to an activity’s implementation schedule

➤ Alerts handled for an activity

➤ Notes submitted about an activity

➤ Similar changes added/confirmed/deleted 

➤ Approval (or retraction of approval) of change 
requests 

➤ Minutes or implementation guideline posted

➤ Management of Action Items

➤ Post Implementation Review updates

➤ Votes posted for a change request

➤ System-induced events include:

➤ Alerts generated for an activity

➤ Processes on a change request, such as risk analysis, 
impact analysis, and collision analysis

To access, use one of the following ways: 

➤ In Analysis module: In the Assess tab in the lower 
pane, click the Review tab and then click the Event 
Log tab.

➤ In Director module: Click Activity Information  
either in the Activity Timeline pane or the Alerts pane 
to open the Activity Information dialog box. Then 
click the Event Log tab.

GUI Element (A-Z) Description

Context The source of the event.

Description A description of the event.
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CI KPIs Tab

Impact CIs Pane

Time The time that the event was written to the Event Log.

User ➤ System-induced events are listed under the user name, 
System. 

➤ User-induced events display the name of the relevant 
user.

Description Displays KPIs (Key Performance Indicators) for the CIs 
impacted by the selected activity. 

The Impact CIs pane has the following panes:

➤ "Impact CIs Pane" on page 185

➤ "Key Performance Indicators Pane" on page 186

To access: 

➤ Select an activity in the Activity Timeline pane and 
click  KPIs for Activity CIs.

or

➤ Select an activity in the Activity Timeline pane, click 
Activity Information , and select the CI KPIs tab.

Important 
Information

➤ This feature is only available if HP Release Control is 
integrated with HP Business Availability Center 8.x.

➤ To view the CI KPIs, HP Business Availability Center 
needs to be running.

Useful Links ➤ For information about configuring this feature, refer to 
the chapter about configuring KPI viewing in the 
HP Release Control Configuration Guide. 

➤ To submit information or comments about an activity, 
see "Notes for Activity <ID> Dialog Box" on page 196. 

➤ To view additional layers of information on the 
timeline, see "Activity Timeline Pane" on page 187.

Description Displays the business and system CIs that are affected by 
the change request.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Key Performance Indicators Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

HP Release Control automatically refreshes the list of 
impact CIs every minute. Click Refresh Activity Timeline 
any time to refresh the display. 

Displays the attributes of the selected CI. Opens the CI 
Attributes dialog box.

<List of impact CIs> The list of business and system CIs that are affected by 
the change request.

When you select one of the CIs in the Impact CIs pane, 
the KPI details are displayed in the Key Performance 
Indicators pane. For a detailed description of the icons in 
this pane, see "Assess > Impact Tab" on page 67. 

Description Displays the details of the KPIs associated with the CI you 
select in the Impact CIs pane.

GUI Element (A-Z) Description

Name The KPI type.

Source The application that provides the KPI information.

Status The status of the KPI.

Value If no status is available, the value of the KPI is displayed. 
The unit of the value is displayed in parenthesis.
186



Chapter 6 • Director Module
Activity Timeline Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Lists activities scheduled within a selected time range, 
and their schedules are displayed graphically on a 
timeline. The graphical representation of the activity 
schedules indicates the status of the activity, that is, 
whether it has not yet started, has started, or is complete, 
and so on. If you modify an activity’s schedule, this is 
indicated on the timeline.

To access: Select Module > Director > Activity Timeline 
pane.

Useful Links "Viewing Activities on the Timeline" on page 176

GUI Element (A-Z) Description

View Layer. Enables you to view additional information 
by adding layers of information to the timeline. Select 
the layer of information you want to display. 

For information on the available layers of information 
you can view, see "Information Layers in the Activity 
Timeline Pane" on page 189.

 Drag mode/Cursor mode. Enables you to modify the 
amount of past and future time you want displayed in 
the timeline area. You can toggle between Drag Mode 
and Cursor Mode.

➤ Click Drag Mode to turn the cursor into a hand when 
you hold it over the timeline area. Drag the timeline 
area to the left to display more time in the future, or to 
the right to display more time in the past. The 
activities displayed are updated according to the new 
time range displayed.

➤ Click Cursor Mode to revert back to the regular cursor.
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Activity Information. Opens the Activity Information 
dialog box. Contains details about the selected activity.

Note: The Activity Information button is also available in 
the Alerts pane.

Update Activity Status. Opens the Update Activity Status 
dialog box. Enables you to update the status on the 
implementor’s behalf if the implementor is unable to 
update the activity status directly.

Reschedule Activity. Opens the Reschedule Activity dialog 
box. Enables you to reschedule an activity to start or end 
earlier or later than the original CAB planned schedule. 

Submit Note to Event Log. Opens the Notes for Activity 
<ID> dialog box. Enables you to submit information or 
comments about an activity to the Event Log.

Open Activity Chat Room. Open a chat room in the 
Communications pane. For details, see "User 
Communication" on page 213.

Refresh Activity Timeline. HP Release Control 
automatically refreshes the Activity Timeline pane every 
minute. At any time, you can click Refresh Activity 
Timeline to refresh the display.

Activities Define a set of criteria by which to determine the 
activities to be displayed in the Activity Timeline pane. 
For details, see "Filters Selection List" on page 168.

ID The reference ID number of the activity in the service 
desk application.

Results The number of activities that are displayed in the Activity 
Timeline pane.

GUI Element (A-Z) Description
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Information Layers in the Activity Timeline Pane

You can view the available layers of information in the timeline—one at a 
time, or simultaneously.

➤ Downtime. Intervals of downtime on CIs during activity implementation. 
Downtime is represented by a solid, dark gray bar.

➤ Link Line. When an activity’s planned and actual implementation 
schedules do not overlap, a thin line links the two schedules.

➤ Planned Time. The original implementation schedule for the activity 
defined by the CAB, represented by an empty bar with a black border.

Summary A description of the activity.

Time Range Modify the time range displayed on the timeline.

Drag the Time Range slider left or right, or use the 
numeric stepper to select the number of hours to display. 
You can select a time range of between 1 and 24 hours. By 
default, a 24-hour time range is displayed.

GUI Element (A-Z) Description
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➤ Implementation Outcome. For activities that have ended, you can view 
the implementation outcomes on the timeline.

➤ Successful . Denotes that the implementation is successful.

➤ Successful with problems . Denotes that the implementation is 
successful but you encountered some problems.

➤ Failed . Denotes that the implementation failed.

➤ Cancelled . Denotes that the implementation is cancelled.

Alerts Pane

Description Displays notifications about problems relating to the 
activities. Alerts also indicate warnings, or can simply be 
informative. 

To access: Select Module > Director > Alerts pane.

Useful Links "Activity Alerts" on page 178
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Show Open Alerts Only. Displays only the open alerts. 
This view hides dismissed alerts and alerts in reminder 
mode.

Note: This is the default view.

Synchronize with Selected Activity. Displays only the 
alerts associated with a selected activity.

Note: To view only the open alerts for the activity, click 
 Show Open Alerts Only.

Group by Activity. Enables you to group alerts in the 
Alerts pane by activity. The alerts are grouped by activity, 
indicated by a bullet adjacent to the alert’s icon. 

Click the bullet to expand the activity’s alerts.

Note: To view only the open alerts for the activity, click 
 Show Open Alerts Only.

Activity Information. Contains details about the selected 
activity. Opens the Activity Information dialog box. 

Note: The Activity Information button is also available in 
the Activity Timeline pane.

Handle Alert. Enables you to determine how to handle an 
alert when an alert is generated. Opens the Handle Alert 
dialog box.
191



Chapter 6 • Director Module
Open Activity Chat Room. Open a chat room in the 
Communications pane. For details, see "User 
Communication" on page 213.

Indicates the alert’s severity. The color of the alert icon is 
determined by the activity’s most severe alert. 

The icon displayed alongside each alert indicates the 
severity of the alert and the alert’s status. 

An alert icon can be:

➤ Red , indicating an error

➤ Yellow , indicating a warning

➤ Blue , indicating a notification

Alerts can have one of the following statuses:

➤ Open . The alert is active.

➤ Dismissed . The alert was acknowledged and 
removed from the Alerts pane.

➤ In reminder mode . The alert is in reminder mode.

Description The ID of the activity. The number in parentheses next to 
the activity ID indicates the number of alerts for the 
activity.

Time The time at which the alert was generated.

GUI Element (A-Z) Description
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CI Attributes Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the attributes of the selected CI.

To access in Analysis Module: 

1  In the Assess tab in the lower pane, click the Impact 
tab.

2  Click CI Attributes  in the Impact CIs pane.

To access in Director Module: 

1  Click Activity Information  either in the Activity 
Timeline pane or the Alerts pane to open the Activity 
Information dialog box.

2  Click the CI KPIs tab

3  Click CI Attributes  in the Impact CIs pane.

Important 
Information

To customize the attributes that are displayed, see 
"Configuring CI Attribute Displays" in HP Release Control 
Configuration Guide.

GUI Element (A-Z) Description

Name The name of the attribute.

Value The attribute’s value.
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Communications Pane

Director Module Window

Description Provides a medium where you can communicate with all 
other users that are involved in a particular activity or are 
interested in a particular topic. For details, see "User 
Communication" on page 213.

To access: Select Module > Director > Communications 
pane.

Included in Tasks "Monitor the Implementation Progress of an Activity" on 
page 179

Description Enables you to monitor the status of change requests 
scheduled for implementation.

This window contains the following panes:

➤ "Activity Timeline Pane" on page 187

➤ "Alerts Pane" on page 190

➤ "Communications Pane" on page 194

To access: Select Module > Director.

Included in Tasks "Monitor the Implementation Progress of an Activity" on 
page 179

Useful Links "Director Module Overview" on page 176
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Handle Alerts Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to determine how to handle an alert.

When an alert is generated, you can select how to handle 
it. You can:

➤ Request an alert reminder

➤ Dismiss the alert

➤ Reopen a dismissed alert or an alert in reminder mode

To access: In the Alerts pane, select the required alert and 
then click  Handle Alert.

Included in Tasks "Monitor the Implementation Progress of an Activity" on 
page 179

Useful Links "Activity Alerts" on page 178

GUI Element (A-Z) Description

Dismiss alert and 
reopen only if an 
alert’s severity 
increases

Enables you to dismiss the alert. 

If the severity of this alert increases, the alert reopens 
with a higher severity. For example, if an alert is about to 
collide with another alert, a warning alert (yellow) is 
generated. If, after you dismiss this alert, the activities do 
collide, the alert reopens as an error alert (red).

Notes (Optional) A free text box for any notes you want to 
associate with the alert.

Remind me again in: Request an alert reminder. In the drop down list, select 
when to activate the reminder.

Reopen alert Reopen a selected alert that has been dismissed. A regular 
alert  icon appears next to the alert, indicating that it 
is open.

Note: To reopen an alert, ensure that Show Open Alerts 
Only  is not selected.
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Notes for Activity <ID> Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Reschedule Activity Dialog Box

Description A free text box for any information or comments you 
want to submit about an activity to the Event Log.

To access: Select the activity you have comments about 
and click Submit Note to Event Log  in the Activity 
Timeline pane.

Useful Links "Event Log Tab" on page 184

GUI Element (A-Z) Description

Notes Notes or information you want to submit about an 
activity to the Event Log.

Description Reschedule an activity to start or end earlier or later than 
the original CAB planned schedule. 

To access: Select the required activity in the timeline and 
click Reschedule Activity  in the Activity Timeline 
pane.

Important 
Information

You can reschedule an activity to start up to 12 hours 
earlier than the original CAB planned start time, and end 
up to 12 hours later than the original CAB planned end 
time. 

Included in Tasks "Monitor the Implementation Progress of an Activity" on 
page 179

Useful Links "Event Log Tab" on page 184
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Update Activity Status Dialog Box

GUI Element (A-Z) Description

Opens a calendar. Select a new time and date.

Note: The updated schedule is displayed on the timeline, 
and the event is logged in the Event Log.

End time Displays the new end time for the selected activity.

Start time Displays the new start time for the selected activity.

Description Update the status on the implementor’s behalf if the 
implementor is unable to update the activity status 
directly.

To access: Select the required activity in the timeline and 
click Update Activity Status  in the Activity Timeline 
pane.

Included in Tasks "Monitor the Implementation Progress of an Activity" on 
page 179
197



Chapter 6 • Director Module
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Actual end ➤ Click  to select the date and time (current or in the 
past) that the activity ended.

➤ Click  to clear the current status.

Notes: 

➤ You must update Actual start before you can update 
Actual end.

➤ If you are fully integrated with HP Service Manager/
Center as your service desk, the Actual end field is 
automatically updated in the originating service desk 
when you update it in the Director module.

Actual start ➤ Click  to select the date and time (current or in the 
past) that the activity started.

➤ Click  to clear the current status.

Note: If you are fully integrated with HP Service 
Manager/Center as your service desk, the Actual start 
field is automatically updated in the originating service 
desk when you update it in the Director module.

Downtime end ➤ Click  to select the date and time (current or in the 
past) that the downtime ended.

➤ Click  to clear the current status.

Note: You must update Downtime start before you can 
update Downtime end.

Downtime start ➤ Click  to select the date and time (current or in the 
past) that the downtime started.

➤ Click  to clear the current status.

Notes: 

➤ You must update Actual start before you can update 
Downtime start.

➤ If you update Downtime start, you must first update 
Downtime end before you can update Actual end.
198



Chapter 6 • Director Module
Notes (Optional) A free text box for any notes you want to add 
about the status update.

On behalf of Select the implementor on whose behalf you want to 
update the activity status. You can choose the name of 
the implementor from the drop-down menu or by 
clicking Select Implementor  and selecting a name 
from the list that appears.

Outcome If you are updating Actual end, the Outcome box is 
enabled. Select one of the following activity outcomes:

➤ Successful. Indicates that the activity was successful.

➤ Successful with Problems. Indicates that overall the 
activity was successful, but had some problems.

➤ Failed. Indicates that the activity failed.

➤ Cancelled. Indicates that the activity was cancelled.

GUI Element (A-Z) Description
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Implementor Module

This chapter includes:

Concepts

➤ Implementor Module Overview on page 201

➤ Managing Activity Implementation on page 202

Tasks

➤ Modify the Implementation Progress of an Activity - Use-Case Scenario 
on page 202

Reference

➤ Implementor Module User Interface on page 205
Concepts

Implementor Module Overview

As an implementor, you can manage the activities assigned to you from the 
Implementor module. You can view activity information and update the 
status of activities on which you are working. In turn, the NOC users are 
notified of the current status of the activity. For details, see "To-Do List Pane" 
on page 209.

From the Implementor module, you can communicate with other 
implementors assigned the same activity, as well as with NOC and other 
users involved in the activity. For details, see "User Communication" on 
page 213.
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Managing Activity Implementation

The Implementor module lists the activities assigned to you over the current 
24-hour period, that is, over the last 12 hours and over the next 12 hours, 
sorted by their scheduled start times.

The current status of each activity is displayed in the To-Do List. As you 
progress through the implementation, you update the status of the activity. 
For information on how to update the status of the activity, see "To-Do List 
Pane" on page 209.

When implementation is complete, you can update the implementation 
outcome. For information on how to update the implementation outcome, 
see "Report Activity As Finished Dialog Box" on page 208.

Tasks

Modify the Implementation Progress of an Activity -
Use-Case Scenario

This task describes how to modify the implementation progress of an 
activity and how to handle the problems that may arise during the 
implementation.

This task includes the following steps:

➤ "View the Activity Information" on page 203

➤ "View Event Log Information" on page 203

➤ "Update the Status of the Activity" on page 203

➤ "Request NOC Assistance" on page 204

➤ "Communicate with Other Implementors" on page 204

➤ "Report the Start of Server Downtime" on page 205

➤ "Report the End of Server Downtime" on page 205

➤ "Report the Activity Outcome" on page 205
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 1 View the Activity Information

Gary Shore is an implementor for ABC Software Company. He is 
responsible for modifying the implementation progress for fixing the 
email notification problem in the HP Release Control server.

In the To-Do List, Gary selects the activity on which he is working. He 
clicks the Activity Information  button to open the Activity Information 
dialog box. Gary then clicks the Implementation Guidelines tab to view 
the CAB-assigned guidelines to follow before and after implementing the 
activity.

Since fixing the email notification problem involves scheduling a period 
of downtime for the HP Release Control server, the pre-implementation 
guidelines require that he notify the relevant people when, and for how 
long, the server will be down.

The post-implementation guidelines require that he give notification 
when the relevant people have been informed of the pending downtime.

For details on the Implementation Guidelines tab, see "Implementation 
Guidelines Tab" on page 183.

 2 View Event Log Information

To confirm that downtime of the HP Release Control server does not 
impact any other critical applications, Gary needs to review information 
related to the activity on which he is working. 

He reviews the information in:

➤ The Event Log. He clicks the Event Log tab in the Activity Information 
dialog box. For details about Event Log information, see "Event Log 
Tab" on page 184.

➤ The Analysis module. In the Activity Information dialog box, he clicks 
the View in Analysis button in the Details tab. For details, see "Details 
Tab" on page 181.

 3 Update the Status of the Activity

Before implementation begins, the activity status is Not started. After 
deciding that he can begin implementation, Gary updates the status of 
the the activity to Report Activity as Started.
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In the To-Do list, he selects the activity on which he is working and clicks 
the Report the Activity as Started button. The status of the activity is 
updated to Started.

For more information about activity status, see "To-Do List Pane" on 
page 209.

 4 Request NOC Assistance

While the email notification problem is being worked on, Gary notices 
another hardware failure in the server he is working on and begins to 
investigate. He submits a message to the NOC users requesting their 
assistance with this problem.

In the To-Do list, Gary selects the activity for which he needs assistance. 
He clicks the Request NOC Assistance button In the To-Do List toolbar to 
open the NOC Assistance Request dialog box. Gary enters his request for 
assistance and clicks OK. The request is sent to the Director module where 
it is displayed as an alert with high severity.

For more information, see "NOC Assistance Request Dialog Box" on 
page 207.

 5 Communicate with Other Implementors

Gary is now ready to implement the planned server downtime, but he 
remembers that his colleague Lauren had been working on the server. So 
he opens an activity chat room to tell her that he needs to take the server 
down.

In the To-Do list, Gary selects the activity about which he wants to chat 
and then clicks the Open Activity Chat Room button in the To-Do List 
toolbar. A chat room window opens in the Communications pane. He 
types his message in the box adjacent to the Send button, and clicks 
Send.

For more information about using the activity chat room, see "User 
Communication" on page 213.
204



Chapter 7 • Implementor Module
 6 Report the Start of Server Downtime

Before Gary takes the server down, he needs to update the status of the 
activity. He selects the activity on which he is working and clicks the 
Report Start of Downtime button in the To-Do List toolbar.

 7 Report the End of Server Downtime

When Gary is ready to restart the server, he selects the activity on which 
he is working and clicks the End Start of Downtime button in the To-Do 
List toolbar.

 8 Report the Activity Outcome

After implementation of the activity has ended, Gary needs to update the 
activity’s status and indicate its outcome. He selects the activity on which 
he is working and clicks the Report Activity as finished button in the 
To-Do List toolbar. The Report Activity as Finished dialog box opens, in 
which he selects the required activity outcome.

For information about activity outcome options, see "Report Activity As 
Finished Dialog Box" on page 208.

Reference

Implementor Module User Interface

This section describes (in alphabetical order):

 ➤ Communications Pane on page 206

 ➤ Implementor Window on page 206

 ➤ NOC Assistance Request Dialog Box on page 207

 ➤ Report Activity As Finished Dialog Box on page 208

 ➤ To-Do List Pane on page 209
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Communications Pane

Implementor Window

Description Provides a medium where you can communicate with all 
other users that are involved in a particular activity or are 
interested in a particular topic. For details, see 
"Communications Pane" on page 215.

To access: Select Module > Implementor > 
Communications pane.

Description The Implementor module lists the activities assigned to 
you over the current 24-hour period, that is, over the last 
12 hours and over the next 12 hours, sorted by their 
scheduled start times.

You can view activity information and update the status 
of activities on which you are working. For information 
on how to update the status of the activity, see "To-Do 
List Pane" on page 209.

When implementation is complete, you can update the 
implementation outcome. For details, see "Report 
Activity As Finished Dialog Box" on page 208.

This window contains the following panes:

➤ "To-Do List Pane" on page 209

➤ "Communications Pane" on page 206

To access: Select Module > Implementor.

Included in Tasks "Modify the Implementation Progress of an Activity - 
Use-Case Scenario" on page 202 

Useful Links "Managing Activity Implementation" on page 202
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

NOC Assistance Request Dialog Box

GUI Element (A-Z) Description

Description A full length description of the selected change.

Summary A brief description of the selected change.

Description If you are an implementor, you can submit a message to 
the NOC users requesting assistance for a certain activity. 
The message is conveyed in the Director module in the 
form of a high severity alert noting that you are in need 
of assistance. For an example of a request that is 
displayed in the Directory module, see "Example of an 
Assistance Request" on page 208.

For more information about the Director module, see 
"Director Module" on page 175.

To access: Select the activity for which you need 
assistance and then click Request NOC Assistance  on 
the To-Do List toolbar.

Included in Tasks "Modify the Implementation Progress of an Activity - 
Use-Case Scenario" on page 202

Useful Links "Managing Activity Implementation" on page 202
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Example of an Assistance Request

This section displays an example of request is sent to the Director module 
where it is displayed as an alert with high severity. 

Report Activity As Finished Dialog Box

Description Enables you to select the required implementation 
outcome in the To-Do List after updating the activity 
status. For information on how to update the status of the 
activity, see "To-Do List Pane" on page 209.

The status in the Status column changes to Done, and the 
Outcome column is updated with the relevant icon. For 
details on the icons that can appear in the Updated 
column, see "To-Do List Pane" on page 209.

To access: Click Report Activity as Finished  from the 
toolbar in the To-Do List.

Included in Tasks "Modify the Implementation Progress of an Activity - 
Use-Case Scenario" on page 202

Useful Links "Managing Activity Implementation" on page 202
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

To-Do List Pane

GUI Element (A-Z) Description

Notes (Optional) Enter your comments about the outcome of 
the activity.

Outcome Select one of the following activity outcomes:

➤ Successful to indicate that the activity was successful.

➤ Successful with Problems to indicate that overall the 
activity was successful, but had some problems.

➤ Failed to indicate that the activity failed.

➤ Cancelled to indicate that the activity was cancelled.

Description The To-Do List displays the activities assigned to you 
over the current 24-hour period, that is, over the last 
12 hours and over the next 12 hours. It displays the 
scheduled start times of the activities, as well as their 
summaries and descriptions. As implementation 
proceeds, the activity status and implementation 
outcome are updated here.

To access: Select Module > Implementor > To-Do List 
pane.

Included in Tasks "Modify the Implementation Progress of an Activity - 
Use-Case Scenario" on page 202

Useful Links "Managing Activity Implementation" on page 202
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Activity Information. Opens the Activity Information 
dialog box. Contains details about the selected activity. 
For details, see "Activity Information Dialog Box" on 
page 181.

Open Activity Chat Room. Open a chat room in the 
Communications pane. For details, see "User 
Communication" on page 213.

Request NOC Assistance. The NOC Assistance Request 
dialog box opens. As an implementor, you can submit a 
message to the NOC users requesting assistance for a 
certain activity. The message is conveyed in the Director 
module in the form of a high severity alert noting that 
the implementor is in need of assistance. For details, see 
"Activity Alerts" on page 178. 

Report Activity as Started. Updates the status of the 
activity to Started.

Note: If you are fully integrated with HP Service Manager/
Center as your service desk, the Report Activity as Started 
field is automatically updated in the originating service 
desk when you update it in the Implementor module.

Report Activity as Finished. Updates the status of the 
activity to Finished. Opens the Report Activity As Finished 
dialog box, prompting you for the implementation 
outcome.

Note: If you are fully integrated with HP Service Manager/
Center as your service desk, the Report Activity as 
Finished field is automatically updated in the originating 
service desk when you update it in the Implementor 
module.

Report Start of Downtime. Reports the start of activity 
downtime.
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Report End of Downtime. Reports the end of activity 
downtime.

Outcome. After you select the required outcome in the 
Report Activity As Finished dialog box, the outcome 
column is updated with one of the following icons:

➤  Successful. The implementation was successful.

➤  Successful with problems. The implementation 
was successful but you encountered some problems.

➤  Failed. The implementation failed.

➤  Cancelled. The activity was cancelled.

Activity ID The reference ID number of the activity in the service 
desk application.

NOC Planned Start 
Time

The planned start time of the activity as rescheduled by 
the NOC users.

Status Before implementation begins, the activity status is Not 
Started. When you start implementation and update the 
status, the Director module is automatically updated as 
well. This enables the NOC users to follow the progress of 
the implementation, and assist where necessary.

To update the activity status in the Implementor module, 
you select the activity you want to update using the 
appropriate buttons in the To-Do List toolbar.

The status for the activity is updated as follows:

➤  Not Started. Before implementation begins, the 
activity status is Not started. 

➤  Started. To update the activity’s status to Started, 
click either Report Activity as Started  or Report 
End of Downtime .

➤  Down. To update the activity’s status to Down, 
click Report Start of Downtime .

➤  Done. Implementation of the change is complete.

GUI Element (A-Z) Description
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User Communication

This chapter includes:

Concepts

➤ User Communication Overview on page 213

Reference

➤ Communications Pane User Interface on page 214
Concepts

User Communication Overview

You can communicate with other users to convey or obtain information 
regarding the common activities with which you are associated, or regarding 
other topics by opening an activity chat room in the Communications 
pane. For details, see "Communications Pane" on page 215.

The Communications pane appears in both the Director and the 
Implementor modules.

➤ Director module users, such as NOC users, Release Managers, and Change 
Managers, communicate from the Director module. For details, see 
"Director Module" on page 175.

➤ Implementors communicate from the Implementor module. For details, 
see "Implementor Module" on page 201.
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Activity Chat Rooms
If you are a NOC user, when you start a chat session, all users who are 
associated with that activity, and who are online, are alerted to the chat 
session. 

If you are an implementor or other non-NOC user, all non-NOC users who 
are associated with the activity, and who are online, are alerted to the chat 
session. To involve NOC users in an activity chat session, you need to force 
their participation.

Note: Users are online when they have opened the Director or Implementor 
module.

Reference

Communications Pane User Interface

This section describes (in alphabetical order):

 ➤ Add New Room Dialog Box on page 214

 ➤ Communications Pane on page 215

 ➤ Manage Chat Rooms Dialog Box on page 218

Add New Room Dialog Box

Description Enter a name for the custom chat room. The chat room is 
added to the list of rooms, listing you as its owner.

To access: Click Add Chat Room  in the Manage Chat 
Rooms dialog box.

Useful Links "User Communication Overview" on page 213
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Communications Pane

Description Enables you to communicate with other users to convey 
or obtain information regarding the common activities 
with which you are associated, or regarding other topics. 
Opens an activity chat room window.

To access in Director module:
1  In the Activity Timeline pane, select the activity about 

which you want chat.

2  On the Activity Timeline or Alerts pane toolbar, click 
Open Activity Chat Room . 

To access in Implementor module:
1  In the To-Do List pane, select the activity about which 

you want chat.

2  On the To-Do List toolbar, click Open Activity Chat 
Room . 

Important 
Information

The Communications pane appears in both the Director 
and the Implementor modules.

Included in Tasks "Monitor the Implementation Progress of an Activity" on 
page 179

Useful Links "User Communication Overview" on page 213
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Enables you to leave a chat room.

Note: This button appears when you hold the cursor over 
the chat room tab, adjacent to the activity ID.

Opens the Manage Chat Rooms dialog box. Enables you 
to create custom chat rooms where you can hold 
discussions about general issues. 

Force NOC users to participate in the chat room. The 
next message you send opens a chat room window in the 
NOC users’ Communications panes. 

Note: This button only appears in the Director module if 
the user is a NOC user.

Users displayed in regular font are online but not in the 
chat room.

Users displayed in bold font are in the chat room.

<Activity ID> The name of the chat room window. The chat room 
window tab is named according to the ID of the activity 
in discussion.
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Send Type a message in the box to the left of the Send button, 
and click Send to send it to the other users. The message 
you send appears in the message pane.

➤ If you are a NOC user, all the users listed are 
automatically forced to participate in the chat session.

➤ A chat room windows open in each user’s 
Communications pane. 

➤ All users in the User List then appear in bold text, 
indicating that they are in the room. 

➤ If you are an implementor or other non-NOC users, 
NOC users are not automatically forced to participate 
the chat session. They continue to appear online, until 
they join the room on their own accord. Alternatively, 
you can force them to participate in the chat room by 
clicking Force NOC Intervention  in the 
Communications pane. The next message you send 
opens a chat room window in the NOC users’ 
Communications panes as well. 

Throughout the chat session, automated messages 
indicate when users come online and go offline, and 
when they join and leave the chat room.

User List Displays all the users associated with the activity in any 
way, who are online.

GUI Element (A-Z) Description
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Manage Chat Rooms Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Create custom chat rooms where you can hold 
discussions about general issues. For example, you can 
create chat rooms where database administrators can 
hold discussions, or where implementors can discuss 
general issues about activities they are implementing. 

To access: Click Manage Chat Rooms  in the 
Communications pane.

Important 
Information

When you create a chat room, you are its owner. Anyone 
can join the chat room. Only you, the owner, can delete 
it.

Included in Tasks "Monitor the Implementation Progress of an Activity" on 
page 179

Useful Links ➤ "Implementor Module" on page 201

➤ "Director Module" on page 175

➤ "User Communication Overview" on page 213

GUI Element (A-Z) Description

Create a custom chat room. Opens the Add New Room 
dialog box.

Deletes the selected chat room.

Note: You can only delete chat rooms that you created.

Join the selected chat room. You can participate in many 
chat rooms at a time, enabling you to discuss different 
issues with relevant fellow users.

A chat room window opens in your Communications 
pane. Other users in the chat room appear in the User 
List.
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Displays the list of chat rooms in which you are 
participating. The drop-down arrow appears when you 
have joined two or more chat rooms.

Owner The name of the user who created the chat room.

Room name Enter a name for the new chat room.

GUI Element (A-Z) Description
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Working with the Dashboard

Note: This chapter describes the Dashboard features available to the regular 
user. If you are an administrator, contact customer support for assistance in 
working with the additional Dashboard features available to you.

This chapter includes:

➤ Viewing the Default Portlets on page 224

➤ Trends Portlets on page 225

➤ Analysis Portlets on page 227

➤ Post Implementation Portlets on page 232

➤ Working with Dashboard Pages on page 236

➤ Personalizing the Dashboard on page 236
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Viewing the Default Portlets

To open the Dashboard, select Module > Dashboard. The Dashboard opens 
displaying the Home tab.

The portlets displayed in the Home tab provide change request information 
based on Trends, Analysis, and Post Implementation. By default, the Trends 
portlets are displayed. 

To display a different set of portlets, click Switch to page, then select 
Release Control Default Module and the desired portlets.

To maximize a portlet, click the Maximize button in the upper right hand 
corner of the portlet. A magnified view of the portlet is displayed on a page 
by itself. To return to the original view, click Back.

Note:

➤ If you are the first user logging on to the application after the server was 
started, the Dashboard may take a few minutes to load. The next time 
you enter the Dashboard, it loads immediately.

➤ The Release Control Default Page cannot be edited or personalized. To 
personalize or edit the preferences on this page, you must copy this page 
to your list of personal Dashboard pages. Copying pages is not available 
by default and must be enabled by the administrator.

➤ If you copied the Release Control Default Page and the administrator 
required a preference to be defined before displaying one of the portlets 
on the page, you must define a preference for this portlet in order to view 
it.

➤ Even if you copied the Release Control Default Page and can, in general, 
edit the preferences on this page, you are not able to edit a portlet 
preference that the administrator preconfigured.
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Trends Portlets

The default Trends portlets display information relating to change requests 
shown over time. The following portlets are displayed:

➤ Changes Over Time Portlet – for details, see page 225 

➤ Abnormal Changes Over Time Portlet – for details, see page 226

➤ Latent Changes Over Time Portlet – for details, see page 226

By default, the Trends portlets are displayed in line chart format. To display 
the same information as a list, select List from the Display drop down list in 
the upper right hand corner of each portlet.

For information on modifying the display preferences of the Trends portlets, 
see "Modifying the Trend Portlets Display Preferences" on page 226.

Changes Over Time Portlet
The Changes Over Time portlet displays the upward or downward 
movement in the number of overall change requests, measured at one week 
intervals. 
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Abnormal Changes Over Time Portlet
The Abnormal Changes Over Time portlet displays the upward or downward 
movement in the number of abnormal change requests, measured at one 
week intervals. 

Latent Changes Over Time Portlet
The Latent Over Time portlet displays the upward or downward movement 
in the number of latent change requests, measured at one week intervals. 

Modifying the Trend Portlets Display Preferences
You can modify the Trend portlets display preferences only after the portlets 
have been copied to your list of personal Dashboard pages.

To modify display preferences:

 1 Click the Edit button. The Edit Preferences page opens, displaying the 
following options:
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➤ Change Title. Clicking this button opens the Change Portlet Title 
window in which you can enter an alternative title for the Changes 
Over Time portlet.

➤ Filter. You can select which category of change requests to include in 
the portlet. The options that appear here are the same as the filter 
options in the Analysis module.

➤ Group by. You can choose to show movement in the number of 
changes over daily, weekly, montly or yearly intervals.

➤ Display preferences summary on portlet. Although, by default, 
preferences are displayed as part of the portlet, you can choose to view 
the portlet without a display of the preferences. To do so, clear the 
Display preferences summary on portlet check box.

 2 Click Done to save your preference settings and return to the default 
Dashboard page.

Analysis Portlets

The default Analysis portlets display analysis information relating to change 
requests. The following portlets are displayed:

➤ Application Severity Distribution Portlet – for details, see page 228

➤ Application Status Distribution Portlet – for details, see page 229

➤ Change Request Impact Analysis Ratio Portlet – for details, see page 231

By default, the Analysis portlets are displayed as clustered bar charts. To 
display the same information as either a pie chart or a list, select the desired 
option from the Display drop down list in the upper right hand corner of 
each portlet.
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Application Severity Distribution Portlet
The Application Severity Distribution portlet displays the number of change 
requests at each severity level, per application, for the request status selected 
by the user.  

For example, the above graph shows that the Help Desk application has:

➤ 2 Pending Approval change requests with a severity level of Low

➤ 5 Pending Approval change requests with a severity level of Medium

➤ 8 Pending Approval change requests with a severity level of High

➤ 6 Pending Approval change requests with a severity level of Critical

Modifying the Display Preferences

You can modify the Application Severity Distribution portlet display 
preferences only after the portlet has been copied to your list of personal 
Dashboard pages.

To modify the display preferences:

 1 Click the Edit button. The Edit Preferences page opens, displaying the 
following options:

➤ Change Title. Clicking this button opens the Change Portlet Title 
window in which you can enter an alternative title for the Application 
Severity Distribution portlet.
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➤ Show Only User Applications. You can modify the default option 
whereby data is displayed only for those applications associated with 
the current user. (You associate applications with the current user in 
the User Settings dialog box. For details, see "User Preferences Dialog 
Box" on page 24.) To display data for all IT applications affected by the 
change requests that HP Release Control processes, select No under 
Show Only User Applications.

➤ Request Status. You can modify the default option whereby data is 
displayed only for requests with the status Pending Approval. To 
display data for requests with a different status, select the required 
status from the Request Status selection box.

➤ Display preferences summary on portlet. Although, by default, 
preferences are displayed as part of the portlet, you can choose to view 
the portlet without a display of the preferences. To do so, clear the 
Display preferences summary on portlet check box.

 2 Click Done to save your preference settings and return to the default 
Dashboard page.

Application Status Distribution Portlet
The Application Status Distribution portlet displays the number of change 
requests for each request status level, per application, that were created 
within the time frame selected by the user. 

For example, the above graph shows that the following change requests 
affecting the Help Desk application were created during the last month:
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➤ 5 change requests with a current status level of Unknown

➤ 17 change requests with a current status level of Assigned

➤ 10 change requests with a current status level of Pending Approval

➤ 17 change requests with a current status level of Approved

➤ 13 change requests with a current status level of In Progress

➤ 19 change requests with a current status level of Closed

Modifying the Display Preferences

You can modify the Application Status Distribution portlet display 
preferences only after the portlet has been copied to your list of personal 
Dashboard pages.

To modify the display preferences:

 1 Click the Edit button. The Edit Preferences page opens, displaying the 
following options:

➤ Change Title. Clicking this button opens the Change Portlet Title 
window in which you can enter an alternative title for the Application 
Status Distribution portlet.

➤ Created Within. You can choose to display data for change requests 
that were created within a time frame other than the default one, Last 
Month. To display data for change requests created within a different 
time frame, select Last Week or Last Two Weeks from the Created 
Within selection box.

➤ Show Only User Applications. You can modify the default option 
whereby data is displayed only for those applications associated with 
the current user. (You associate applications with the current user in 
the User Settings dialog box. For details, see "User Preferences Dialog 
Box" on page 24.) To display data for all IT applications affected by the 
change requests that HP Release Control processes, select No under 
Show Only User Applications. 

➤ Display preferences summary on portlet. Although, by default, 
preferences are displayed as part of the portlet, you can choose to view 
the portlet without a display of the preferences. To do so, clear the 
Display preferences summary on portlet check box.
230



Chapter 9 • Working with the Dashboard
 2 Click Done to save your preference settings and return to the default 
Dashboard page.

Change Request Impact Analysis Ratio Portlet
The Change Request Impact Analysis Ratio portlet displays both the number 
of change requests for which impact analysis results were available as well as 
the number of change requests for which impact analysis results could not 
be found, for the request status selected by the user.

For example, the above graph shows the following:

➤ Impact analysis results were available for 92 Pending Approval change 
requests.

➤ No Impact analysis results were found for 13 Pending Approval change 
requests.
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Modifying the Display Preferences

You can modify the Change Request Impact Analysis Ratio portlet display 
preferences only after the portlet has been copied to your list of personal 
Dashboard pages.

To modify the display preferences:

 1 Click the Edit button. The Edit Preferences page opens, displaying the 
following options:

➤ Change Title. Clicking this button opens the Change Portlet Title 
window in which you can enter an alternative title for the Change 
Request Impact Analysis Ratio portlet.

➤ Request Status. You can modify the default option whereby data is 
displayed only for requests with the status Pending Approval. To 
display data for requests with a different status, select the required 
status from the Request Status selection box.

➤ Display preferences summary on portlet. Although, by default, 
preferences are displayed as part of the portlet, you can choose to view 
the portlet without a display of the preferences. To do so, clear the 
Display preferences summary on portlet check box.

 2 Click Done to save your preference settings and return to the default 
Dashboard page.

Post Implementation Portlets

The default Post Implementation portlets display information relating to 
completed change requests. The following portlets are displayed:

➤ Outcome Over Time Portlet – for details, see page 233

➤ Outcome Grouped By Risk Portlet – for details, see page 234
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Outcome Over Time Portlet
The Outcome Over Time portlet displays the upward or downward 
movement in the percentage of each change outcome, measured at one 
week intervals. 

By default, the portlet is displayed in line chart format. To display the same 
information as a list, select List from the Display box in the upper right hand 
corner of the portlet.

Modifying the Display Preferences

You can modify the Outcome Over Time portlet display preferences only 
after the portlet has been copied to your list of personal Dashboard pages.

To modify the display preferences:

 1 Click the Edit button. The Edit Preferences page opens, displaying the 
following options:

➤ Change Title. Clicking this button opens the Change Portlet Title 
window in which you can enter an alternative title for the Changes 
Over Time portlet.

➤ Filter. You can select which category of change requests to include in 
the portlet. The options that appear here are the same as the filter 
options in the Analysis module.

➤ Group by. You can choose to show movement in the percentage of the 
different change outcomes over daily, weekly, montly or yearly 
intervals.
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➤ Display preferences summary on portlet. Although, by default, 
preferences are displayed as part of the portlet, you can choose to view 
the portlet without a display of the preferences. To do so, clear the 
Display preferences summary on portlet check box.

 2 Click Done to save your preference settings and return to the default 
Dashboard page.

Outcome Grouped By Risk Portlet
The Outcome Grouped By Risk portlet displays the percentage of change 
requests with specific outcomes, grouped within intervals of calculated risk 
values. 

For example, the above portlet shows that for completed change requests 
that had a risk value between 0 and 9:

➤ 22% have the outcome Successful With Problems

➤ 78% have the outcome Not Reviewed

➤ None have the outcome Cancelled

➤ None have the outcome Failed

By default, the portlet is displayed as a clustered bar chart. To display the 
same information as a stacked bar chart or a list, select the desired option 
from the Display drop down list in the upper right hand corner of the 
portlet.
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Modifying the Display Preferences

You can modify the Outcome Grouped by Risk portlet display preferences 
only after the portlet has been copied to your list of personal Dashboard 
pages.

To modify the display preferences:

 1 Click the Edit button. The Edit Preferences page opens, displaying the 
following options:

➤ Change Title. Clicking this button opens the Change Portlet Title 
window in which you can enter an alternative title for the Changes 
Over Time portlet.

➤ Filter. You can select which category of change requests to include in 
the portlet.

➤ Numeric Type. You can choose to view change outcomes according to 
any numeric field as defined in your system settings.

➤ Minimum Value. The lowest value of the numeric type to include in 
the portlet.

➤ Maximum Value. The highest value of the numeric type to include in 
the portlet.

➤ Interval. You can define at which numeric intervals to group the 
change requests.

➤ Display preferences summary on portlet. Although, by default, 
preferences are displayed as part of the portlet, you can choose to view 
the portlet without a display of the preferences. To do so, clear the 
Display preferences summary on portlet check box.

 2 Click Done to save your preference settings and return to the default 
Dashboard page.
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Working with Dashboard Pages

The following buttons are available at the top of a Dashboard page:

If the page is a public page and the administrator has configured access to 
the page for a number of users, the words Shared Page appear in the top 
right-hand corner of the page.

Personalizing the Dashboard

You can personalize the Dashboard by adding groups and pages within these 
groups, choosing the portlets to be displayed on each page, and specifying 
the positions of the portlets on the page.

You personalize groups, pages, and portlets in the Personalize screen, which 
you can access by clicking the Personalize button in the top right-hand 
corner of the current page, or the Personalize tab in the top menu.

This section describes:

➤ "Adding Groups" below

➤ "Adding Pages" on page 237

Button Description

The Favorites button enables you to add the current page to your 
favorites, or to open the Manage Favorites page.

The View Module Comments button enables you to view the comments 
that the administrator entered for the current module (available only if 
the page is public and is part of a module defined by the administrator).

The Page Rotation button enables you to determine the refresh rate for 
the current page.

The Export Dashboard Page to PDF button enables you to create a PDF 
containing the data on the current page. 

The Personalize button enables you to open the Personalize screen and 
personalize the Dashboard. Clicking this button opens the current 
portlet for editing. For details, see "Personalizing the Dashboard" below.
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➤ "Copying Pages" on page 238

➤ "Modifying Pages" on page 239

➤ "Adding Portlets" on page 240

➤ "Managing Portlets" on page 241

Adding Groups
You can add groups under which you can place pages. This enables you to 
categorize your personal pages.

To add a group:

 1 In the Personalize screen, select Private pages in the Dashboard page tree.

 2 Click the Add button and select New Group. A new group is added to the 
Dashboard page tree.

 3 In the Edit Group pane on the right, enter a name for the new group and 
a brief description of the group. The new group is renamed in the 
Dashboard page tree.

Adding Pages
You can add new blank pages either to the groups that you created or 
directly to the Dashboard page tree. You then populate these pages with 
portlets.
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If you have been assigned the necessary privileges, you can also add 
preconfigured pages (also referred to as modules). Preconfigured pages are 
sets of pages containing portlets that the administrator has already created.

To add a new page to the Dashboard page tree:

 1 In the Personalize screen’s Dashboard page tree, select Private pages or 
the specific group to which you want to add a page. 

 2 Click the Add button and select New Page. A new page is added to the 
Dashboard page tree.

 3 In the Edit Page pane on the right, enter a name for the new page. The 
new page is renamed in the Dashboard page tree.

 4 Specify how often you want the data on the page to be refreshed by 
selecting the Automatically refresh this page every X minutes check box 
and entering the refresh rate. By default, the Dashboard does not refresh 
pages.

After creating the page, you can populate it with portlets. For more 
information, see "Adding Portlets" on page 240.

To add a preconfigured page to the Dashboard page tree:

 1 In the Personalize screen’s Dashboard page tree, select Private pages. 

 2 Click the Add button and select Add Preconfigured Pages. The Add 
Preconfigured Pages dialog box is displayed in the right pane.

 3 Select the check box to the left of the modules whose pages you want to 
add to the Dashboard page tree. Each module you select is added as a 
group in the tree. The module’s pages appear under the group created for 
the module.

Copying Pages
You can copy pages from one group to another in the Dashboard page tree. 
In addition, if you have been assigned the necessary privileges, you can copy 
a shared module (containing several pages) or page to the list of your 
personal Dashboard pages.
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To copy a module or page:

 1 Select the module or page you want to copy (either in the Dashboard page 
tree or under Shared pages) and click the Copy button.

 2 In the Dashboard page tree, select Private pages or the group under which 
you want to place the copied module or page, and click the Paste button. 
The module or page is copied to the selected location.

Modifying Pages
You can change the order of the Dashboard pages in the Switch to page list. 
You can also rename and remove pages, and modify the refresh rate of a 
page.

To modify a page:

Access the Personalize screen.

➤ To change the position of a page in the Switch to page list, change the 
position of the page in the Dashboard page tree by clicking the Up and 
Down buttons.

➤ To rename a page, select the page in the Dashboard page tree and enter a 
new name in the Edit Page pane’s Page Name box.

➤ To remove a page from the Dashboard, select the page in the Dashboard 
page tree and click the Delete button. Click Yes to confirm deletion.

➤ To modify the refresh rate of a page, select the page in the Dashboard 
page tree, then select the Automatically refresh this page every X minutes 
check box and specify a new refresh rate in the Edit Page pane.

➤ To add portlets to a page, see "Adding Portlets" on page 240.

➤ To modify how portlets are displayed on a page, see "Managing Portlets" 
on page 241.
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Adding Portlets
You can add portlets to a selected page. Note that to optimize the time that 
it takes to load a page and make the page easy to view, it is recommended 
that you limit the number of portlets on a page to six.

To add a portlet to a page:

 1 In the Personalize screen’s Dashboard page tree, select the page to which 
you want to add portlets and click Add Portlets in the Edit Page pane. The 
Add Portlets window opens.

 2 In the Portlet Name box, enter the name of the portlet you want to add to 
the page.

 3 From the Category box, select the category to which the portlet belongs if 
the administrator has defined portlet categories.

 4 Click Add.

Alternatively, click Find Portlets to display a list of available portlets, 
select the portlets that you want to add to the page, and click Add.

The portlets you specified are added to the page in both the Edit Page 
pane and the Dashboard page tree.

To rearrange the order in which the portlets are displayed, or to move or 
remove portlets from a page, see "Managing Portlets" on page 241.
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Managing Portlets
This section describes the following Dashboard functionality:

➤ Arranging Portlets on a Page – for details, see below

➤ Copying Portlets to Other Pages – for details, see below

➤ Renaming Portlets – for details, see page 242

➤ Removing Portlets from Pages – for details, see page 242

Arranging Portlets on a Page

You can determine the layout of the portlets on each of the Dashboard 
pages.

To arrange the portlets on a page:

 1 In the Edit Page pane, select the portlet you want to move. Selecting the 
portlet causes it to be highlighted on the page.

 2 Drag the portlet to its new position.

For each portlet you want to move, repeat steps 1 and 2.

The portlets appear in their new positions in the Edit Page pane and 
Dashboard page tree.

Copying Portlets to Other Pages

You can copy an existing portlet from one personal page to another. You can 
also copy a shared portlet to a personal page if you have been assigned the 
necessary privileges by the administrator.

Note: To optimize the time that it takes to load a page and make the page 
easy to view, it is recommended that you limit the number of portlets on a 
page to six.

To copy a portlet to another page:

 1 Select the portlet that you want to copy and click the Copy button.
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 2 Select a page in the Dashboard page tree and click the Paste button. The 
portlet is copied to the selected page.

Note: The new portlet’s name is the original portlet’s name preceded by 
Copy of. To rename the copied portlet, see "Renaming Portlets" below.

Renaming Portlets

Renaming a portlet is useful when the same portlet is duplicated with 
different preferences in each copy.

To rename a portlet:

 1 In the Edit Page pane, select the portlet that you want to rename and click 
the Edit Portlet Preferences button. The Edit Preferences: <name of 
portlet> pane is displayed.

 2 Click Change Title. The Change Portlet Title window opens.

 3 Enter the new name (with a maximum of 30 characters) in the Title box 
and click Change. The new portlet title is displayed in the Edit Page pane 
and Dashboard page tree.

Removing Portlets from Pages

You can remove a portlet from a Dashboard page. Note that this does not 
affect other occurrences of the portlet on other Dashboard pages.

To remove a portlet from a page:

 1 In the Dashboard page tree, select the portlet that you want to remove 
and click the Delete button. Alternatively, in the Edit Page pane, select 
the portlet that you want to remove, and click the Remove Portlet From 
Page button .

 2 Click Yes to confirm deletion. The portlet is removed from the Edit Page 
pane and Dashboard page tree.
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